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Introduction to Legacy HawkSoft 
Help Documentation
Version 5 of the HawkSoft Management System has reached its end of support. The following doc-

uments are an offline copy of the legacy Version 5 online help portal, provided as a courtesy to your 

agency, which has elected to remain on HawkSoft version 5.

Please keep the following in mind as you navigate this help documentation:

 l To prevent issues with size, portability, and navigability, the Version 5 help documentation has 

been split into nine PDF files (including this one). If a help topic contains a link to a different topic 

which does not seem to function properly, it most likely links to a topic contained in a different 

PDF file. In that case, try searching the other PDF files for the topic named in the link.

 l While some topics may mention contacting Product Support for assistance, please note that 
HawkSoft Product Support assistance of any kind is no longer available for this version 
of HawkSoft.

 l While we have done our best to remove any topics relating to online features that are no longer 

functional, this help documentation may still contain references to features which are no longer 

functional due to HawkSoft 5's end of support.

 l Help and training videos are not available in this help documentation. However, you may still 

occasionally see references to help or training videos in this documentation.

Communications Overview
HawkSoft CMS provides a variety of ways in which users can correspond with customers, prospects, 

and other contacts entered into the CMS database.

Emails, letters, memos, proposals, and text messages can be created, and then printed and/or sent 

from the client files using the Action menu. Data from client files can be inserted into correspondence 

using merge fields.
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These correspondences will be documented and attached to the client file. This is important for future 

reference, as well as Errors & Omissions concerns.  See Correspondence Setup Overview for more 

information.

Some template setup is necessary to get the most from these correspondence features.  See Cor-

respondence Setup Overview for more information.

Text Messages
If your agency is looking to deliver real-time customer service to your clients, it's hard to beat the con-

venience of text messaging. HawkSoft offers two options for text messaging:

 l HawkSoft Text Messaging: Enables real-time text message conversations with clients from 
CMS. The feature is included as part of your HawkSoft subscription and enabled through the 

Marketplace. 

 l Email-to-SMS: Sends text messages to clients via email in CMS. Replies from clients are sent 
back to an email address. This option requires a paid subscription from a supported Email-to-

SMS provider. 

Text Messaging Overview

Form Letters
Form letter templates are created by the agency for specific purposes, for example, notices of pending 

cancellation. Merge fields are used to pull information from client and policy files.

Form Letters

Microsoft Word Form Letters

Merge Field Descriptions

Batch Mailing
Batch mailing using Report Generator enables your agency to send a mass mailing to all (or selected) 

clients from a report.

Batch Mailing (Print)

#Correspondence%20Setup%20Overview
#Correspondence%20Setup%20Overview
#Correspondence%20Setup%20Overview
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Mailing Labels
CMS provides address labels that make use of form letter templates and Avery® label styles 5160 and 

8160. One default Avery label template is addressed to the named insureds. The other is addressed to 

the named insureds or "current resident".

Mailing Labels

Memos
Memos are one-time communications mailed to recipients that do not need a prepared form letter tem-

plate. They are generally configured to pull basic name and address information from a client file. A 

user can then edit the message as needed.

Memos

Proposals
Proposals are created for marketing purposes and can consist of cover and post letters, line of busi-

ness descriptions, and any attachments or photos that the user chooses to include. Multiple policies 

can be included within the same proposal package.

Proposals

Policy Overview Summaries
Policy summaries are documents that describe the policies in varying levels of detail. The Policy Over-

view is a simplified summary with carrier, term, and coverage information.

Client, Policy, and Claims Summaries

Modifying Correspondence (Letters, Memos,  Proposals, and 

Policy Overview)
HawkSoft CMS enables you to  make formatting changes and insert merge fields, signatures, and other 

elements into  your letters, memos, proposals, and the Policy Overview. 

Modifying Correspondence (Letters, Memos,  Proposals, and Policy Overview)
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Email
Whether using prepared templates or not, email can be sent directly from a client file in CMS. This 

action creates a log note in the client file that includes the content of the email. When items from the 

policy Attachments list are added to an email, a record of the attachment is included in the log note.

Email

Batch Emailing
This article describes how to use the CMS Batch Email feature to send a form email to a large list of 

customers or prospects.

Batch Emails

Modifying Email
HawkSoft CMS enables you to  make formatting changes and insert merge fields, logos  and other ele-

ments to  your emails.

Modifying Email

Merge Field Descriptions
The HawkSoft CMS Letter Editor enables you to create form letters and other types of cor-

respondence. You can add CMS merge fields that pull information from client and policy files into CMS 

templates and letters.

This article describes each CMS merge field used in the letter editor. Each merge field represents the 

information that appears in the finished letter.

Merge Field Descriptions

Text Messaging Overview
If your agency is looking to deliver real-time customer service to your clients, it's hard to beat the con-

venience of text messaging.
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 HawkSoft offers two options for sending text messages from within CMS:

HawkSoft Text Messaging  Email-to-SMS Services

 l Available through HawkSoft Marketplace 

at an additional cost of $20 per month per 

agency

 l Requires a paid sub-

scription from a sup-

ported Email-to-

SMS provider 

 l Requires Data Syncing  l Sends text mes-

sages to clients via 

email. Text mes-

sages appear to 

come from the 

agency's existing 

phone number

 l Enables real-time text message con-

versations with clients from a central 

phone number, different from the 

agency's existing phone number

 l
Upon request, and for 
a one-time fee of $99, 
HawkSoft can use the 
agency's existing 
phone number with 
HawkSoft 
Text Messaging. See 
Purchasing HawkSoft 
Text Messaging for 
more information.

 l Sends text mes-

sages to clients via 

email. Text mes-

sages appear to 

come from the 

agency's existing 

phone number 

 l Each client's full text message history is 

viewable directly from within their client 

file

 l Replies from clients 

are sent back to an 

email address

 l Users can send a text from the Action   l Users can send a 

HawkSoft Marketplace.htm
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HawkSoft Text Messaging  Email-to-SMS Services

menu, main toolbar, and various texting 

views

text from the Action 

menu

 l Users are notified in CMS when a text is 

received

 

 Learn More:

About HawkSoft Text Messaging

 Learn More: 

Text Messaging with 

Email-to-SMS Services

About HawkSoft Text Messaging

HawkSoft Text Messaging enables you to send text messages to your clients  and manage 

their replies directly from HawkSoft CMS. This feature is available to your agency as an 

add-on service, and is purchased through the Marketplace.

This topic provides links to additional articles to help you set up text messaging as well as 

everything you need to know to use the text messaging feature.

As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to a third-party email-to-text messaging service provider and 
send text messages directly from a client file. This feature enables you to use your 
existing mobile number.

See Text Messaging Overview for more information.

Notes about HawkSoft Text Messaging

 l Opt in required
Federal law requires your customers to opt in to receive text messages from your agency. This is 

mandated by the FCC’s Telephone Consumer Protection Act. HawkSoft automates this opt in 

process with the click of a button. Learn more.

 l Texting is not for marketing purposes
HawkSoft Text Messaging is only for informational texts. You may be in violation of federal 

HawkSoft Marketplace.htm
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and/or state regulations if you use texting for marketing purposes. You can read more about best 

practices for text messaging and maintaining TCPA compliance on our blog.

 l Your agency receives one text messaging phone number
Your agency is assigned one central text message phone number. Even if multiple staff mem-

bers are texting a client, that client will see text messages arriving from a single phone number.

Purchasing HawkSoft Text Messaging

To take advantage of this feature, your agency must first enable . Once Data Sync has 

been enabled, a billing contact  for  your agency can purchase Text Messaging through the 

Marketplace. 

See Purchasing HawkSoft Text Messaging for detailed steps on how to purchase the text 

messaging feature. 

Text Messaging Opt in Workflow & Compliance

FCC requires all clients opt in to receive text messages from your agency. HawkSoft sim-

plifies this requirement with an automated opt-in workflow.

Text Messaging Opt-In Compliance

Viewing & Sending Text Messages

HawkSoft makes it easy to view client text messages and send replies from a variety of loc-

ations within CMS. Available views and options depend on your texting permissions.

Viewing & Sending Text Messages

Processing Text Messages

Once you have taken action as a result of the text conversation, you can copy the relevant 

texts into a log note to document history   and mark the texts as "processed." This guide 

details our recommended workflow for processing text messages.

Processing Text Messages

https://blog.hawksoft.com/texting-best-practices-tcpa-compliance
#Permissions
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Unmatched Texts

When a text message is received from a number that does not match a client file, those 

texts are collected in the "Unmatched Texts" view. Learn how to match text messages with 

a client file in this guide.

Unmatched Texts

Text Message Notification Settings

HawkSoft CMS keeps your team updated on incoming text messages through real-time 

notifications and text counts.

You can receive text notifications and number of incoming texts for:

 l Clients for which you are listed as a policy CSR or producer.

 l  Clients you choose to follow.

 l Any unmatched text messages.

Text Message Notifications

Cancelling HawkSoft Text Messaging

If your agency no longer wishes to use HawkSoft Text Messaging, agency administrators 

can download your agency's texting history and attachments and cancel your subscription 

through the HawkSoft Marketplace.

Cancelling HawkSoft Text Messaging

Purchasing HawkSoft Text Messaging

HawkSoft Text Messaging enables you to send text messages to your clients  and manage their replies 

directly from HawkSoft CMS. This feature is available to your agency as an add-on service, and is pur-

chased through the Marketplace.

This guide walks you through the steps to purchase and set up Text Messaging for your agency. Since 

HawkSoft Text Messaging is a Data Sync feature, you must first enable HawkSoft Data Sync from the 

Marketplace.

#Following_Client_Texts:
../../../../../Content/Text Messaging/Cancelling HawkSoft Text Messaging.htm
HawkSoft Marketplace.htm
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As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to an  email-to-text messaging service provider and send text 
messages directly from a client file. 

See Text Messaging Overview for more information.

In this topic:

Notes on HawkSoft Text 

Messaging

Before You Begin Register for HawkSoft Text 

Messaging

Purchasing HawkSoft 

Text Messaging

Purchasing HawkSoft 

Text Messaging

Purchasing HawkSoft 

Text Messaging

Notes on HawkSoft Text Messaging

 l Opt in required
Federal law requires your customers to opt-in to receive text messages from your agency. This is 

mandated by the FCC’s Telephone Consumer Protection Act. HawkSoft automates this opt-in 

process with the click of a button. Learn more.

 l Texting is not for marketing purposes
HawkSoft Text Messaging is only for informational texts. You may be in violation of federal 

and/or state regulations if you use texting for marketing purposes.

 l Your agency receives one text messaging phone number
Your agency is assigned one central text message phone number. Even if multiple staff mem-

bers are texting a client, that client will see text messages arriving from a single phone number.

Before you begin

Before purchasing HawkSoft Text Messaging, you must first register for the HawkSoft Marketplace and 

enable HawkSoft Data Sync so the application can access your HawkSoft data.

Your email address must be listed on the HawkSoft License Agreement as a main contact.

Register for the HawkSoft Marketplace

#Notes_on_Hawksoft_Text_Messaging
#Notes_on_Hawksoft_Text_Messaging
#Before_You_Begin
#Register_For_Hawksoft_Text_Messaging
#Register_For_Hawksoft_Text_Messaging
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The HawkSoft Marketplace offers  agency managers the option to enable HawkSoft Data Syncing,  pur-

chase and configure HawkSoft products, and  integrate with third-party applications. 

 1.  Click the   Settings icon on the  the  HawkSoft CMS toolbar, and then select  Marketplace.

 2.  Click Register Now.

 3.  Enter your Email Address, and then click Submit.

Your email address must be listed on the HawkSoft License Agreement as a main contact. If you 

receive an error indicating your email address is not listed as a main contact, or your current 

email address is different than the one used for the HawkSoft License Agreement, please have 

your agency owner contact billing@hawksoft.com to update your information, and then try again.

An Authentication Code is sent to your email address.

 4.   Copy the code from the email and paste it into the corresponding field on the Marketplace regis-

tration window.

 5.  Check the box below the Authentication Code field stating you agree to the Terms 
and Conditions for HawkSoft Marketplace.

 6.  Click Submit.

A confirmation message appears. 

 7.  Close the HawkSoft Marketplace Registration screen. 

You are ready to enable additional HawkSoft products and third-party applications. 

Enable HawkSoft Data Sync

You can enable  HawkSoft Data Sync to leverage the power of your HawkSoft data  and integrate with 

third-party services as they become available in HawkSoft Marketplace. 

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > General Configuration Settings

See Setting User Permissions for more information.

mailto:billing@hawksoft.com
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 1.  Click the   Settings icon, and then select  Marketplace.

If you haven't registered for the Marketplace, see HawkSoft Marketplace for detailed instruc-

tions.

 2.  Click and read the HawkSoft Terms and Conditions in the HawkSoft Data Sync section, and 

then check the box to accept the Terms and Conditions.

 3.  Click Activate.

The HawkSoft Cloud Confirmation window opens.

 4.  Click Confirm.

A confirmation message appears.

 5.  Click the Return to Marketplace button.

Purchase HawkSoft Text Messaging

Once Data Sync is enabled, you can register for Text Messaging through the Marketplace.

 1.  Click the   Settings icon, and then select  Marketplace.

 2.  Under HawkSoft Text-Messaging, click Activate.

Important HawkSoft Text Messaging Information displays.

 3.  Review the opt-in requirements, rules regarding use for marketing purposes, information about 

your phone number, read the terms and conditions, and then click Next.

 4.  Determine if your agency will require users to opt-in before sending messages, allow users to 

skip the opt-in process, or if HawkSoft's opt-in process will be disabled for your agency. 

Federal regulations require that agencies receive opt-ins from clients before 
sending text messages. If you choose to disable opt-ins, or allow agents to 
skip opt-ins, you agree to receive opt-ins from clients through other means. 
HawkSoft is not responsible for any fines or penalties imposed by telecom 
carriers for non-compliance.

See Text Messaging Opt-In Compliance to learn more. 

 5.  Enter a phone number for clients with questions to call in the "Help" Response section.

When a client sends the phrase 'HELP' to your texting number, an automated message will dir-

ect the customer to call this number.

../../../../../Content/HawkSoft Integrations and Product Add Ons/HawkSoft Marketplace.htm
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 6.   Enter an Area Code or Zip Code to generate a localized phone number to be used by your 
agency for text messaging, and then click Finish. 

 In some metropolitan areas, your desired area code may be unavailable. If 
you receive this error message, use a zip code to generate your phone num-
ber.

 7.  Check "I understand my agency will be charged $20.00 per month starting on my next 
HawkSoft invoice."

 8.  Read the Additional Required Information.

This section explains that additional information will be required on the next page in order to 

register your agency with The Campaign Registry (TCR). Telecom carriers require that all busi-

nesses sending text messages register their business with TCR.

 9.  Click Finish to complete your order.

A Congratulations page appears, which shows the status of your HawkSoft texting number and 
lists the next steps towards enabling HawkSoft Text Messaging.

Complete required information to start registration process

Additional information is required to register your agency with The Campaign Registry (TCR) before 

HawkSoft Text Messaging can be enabled. Telecom carriers require that all businesses sending text 

messages register their business, or "brand", with TCR.

If this information is not filled out by the agency, a HawkSoft representative will contact your agency to 

gather this information.

If you are interested in using your agency's main phone number as your HawkSoft 
Texting number, you can request to enroll in Main Number Texting through the 
Required Information Form. See Purchasing HawkSoft Text Messaging for more 
information.

 1.  Open The Campaign Registry Required Information Form in your web browser.

 2.  Fill out the information requested in the form.

 3.  Click Submit Information to send this information to HawkSoft.

HawkSoft will use this information to register the agency in The Campaign Registry.

 4.  Close the Marketplace window and return to HawkSoft CMS.

https://www.hawksoft.com/10dlc
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HawkSoft submits this information to The Campaign Registry. After  registration is complete within 

TCR, HawkSoft will activate Text Messaging for your agency.

HawkSoft will send an email to your agency's main contacts once Text Messaging is activated. 

If your agency previously used a different text messaging integration (such as Bulk SMS or Message 

Media), HawkSoft Text Messaging will be automatically set as the default texting tool within all  User 

Settings after activation. If the additional text messaging service is no longer needed, you may cancel 

the service.

Once your agency receives notification that HawkSoft Text Messaging is activated, 
all users must restart CMS in order to begin using HawkSoft text messaging.

Your texting number

Once you complete your HawkSoft Text Messaging order, HawkSoft begins creating and registering a 

new texting number from your agency, using the area code provided on the previous page.

It can take up to five minutes for HawkSoft to register your new phone number. You can click the 

refresh   button after waiting, or view your number at a later time by re-opening the Marketplace 

and clicking Manage under HawkSoft Text Messaging.

Main Number Texting
Upon request, HawkSoft can set up your agency's main phone number as your HawkSoft 

Text Messaging number. There is a $99 one-time fee for enabling Main Number Texting.

Not all phone numbers are able to be used for Main Number Texting. 
Your agency will not be charged the one time fee  until  your requested 
phone number has been successfully enrolled in Main Number Tex-
ting.

HawkSoft Text Messaging setup must be completed before the pro-
cess for enrolling in Main Number Texting can begin. Your agency will 
use the separate texting number ordered through the Marketplace until 
the enrollment is complete.

 1.  Complete and submit  The Campaign Registry Required Information Form in your 

web browser.

https://www.hawksoft.com/10dlc
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If your agency already submitted the form  but selected not to 
enroll in Main Number Texting, and you would now like to switch 
to your agency's main number, contact Product Support for 
assistance.

 a.  Within the Required Information Form,  select Yes next to "Do you wish to 
enroll in Main Number Texting?"

 b.  Complete the additional fields that appear with your main number, your phone 

service provider, the business name you use with your phone service pro-

vider, and the service address you use with your phone service provider.

Once HawkSoft is notified of intent to enroll, the agency principal will receive an 

email from HawkSoft staff containing a Letter of Authorization and signing instruc-

tions. If your agency did not complete the additional Main Number Texting fields 

within the TCR Required Information Form, you will be asked to provide additional 

information.

 2.  Complete the Letter of Authorization.

 3.  Reply to the email from HawkSoft with the completed Letter of Authorization 

attached. Provide any additional information needed within your reply, if requested 

to do so by HawkSoft.

Upon receipt, HawkSoft informs all agency main contacts that HawkSoft will now 

attempt to get the requested phone number for Main Number Texting, and will notify 

the agency when the process is complete.

You will receive an email from HawkSoft confirming that your agency is now signed 

up for Main Number Texting, using the number you requested.

Once Main Number Texting is enabled, all old messages and 
opt-ins will remain, however your previous HawkSoft Text Mes-
saging number will no longer be active, and any texts sent to the 
old texting number  will not be received going forward. Make sure 
to inform your clients of the changed texting number.

 If HawkSoft is unable to get the requested number, HawkSoft will inform the 

agency's main contacts, and you may request to try a different number.

https://www.hawksoft.com/10dlc
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Text messaging administration 

Once HawkSoft Text Messaging is enabled, all users can begin sending outgoing text messages to cli-

ent files they have access to. Administrators can disable text messaging for certain users within User 

Permissions. 

Available Texting Permissions:

 l Client File > Allow Sending Text Messages: Grants permission for CMS users to send out-
going texts to clients.

 l Setup > Texting Administration: Allows users to view all text messages, regardless of client 
file permissions, via the All Unprocessed Text Menu.

Permissions are not required to viewtext messages, so long as the user has permissions to access the 

client's file. 

See About HawkSoft Text Messaging for more information on HawkSoft Text Messaging workflows.

Related Topics 
Processing Text Messages
Text Message Notifications
Text Messaging Opt-In Compliance
Viewing & Sending Text Messages

Text Messaging Opt-In Compliance

Federal law requires your clients to opt in to receive text messages from your agency. This is man-

dated by the FCC’s Telephone Consumer Protection Act. 

As part of setting up HawkSoft Text Messaging for your agency, you are given the option to auto-

matically require clients to opt in before receiving text messages from your agency. 

In this topic:

  Configuring Opt-In Settings Sending an Opt-In Request

Verify Client Opt-In Status Manually Opt-Out a Phone 

Number

Resend Opt-In Texts

#All
https://www.fcc.gov/general/telemarketing-and-robocalls
#Configuring_Opt_In_Settings
#Send_an_Opt_In_Request
#Verify_Client_Opt-In_Status
#Manually_Opt-Out_a_Phone_Number
#Manually_Opt-Out_a_Phone_Number
#Resending_Opt_In_Texts
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This guide walks you through the steps to change the opt-in requirement setting after setup is com-

plete. 

As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to an  email-to-text messaging service provider and send text 
messages directly from a client file. This feature enables you to use your existing 
mobile number.

See Text Messaging Overview for more information.

Configuring opt-in settings

During setup, HawkSoft provides three options to address opt-in requirements:

Use HawkSoft's automated opt-in process – This option requires that all users send an automated 
opt-in message to clients. Clients must reply "yes" to this message before outgoing texts can be sent. 

This is the recommended option as it helps your agency maintain compliance with federal regulations.

Allow users to accept legal liability for my agency and skip the opt-in process – This option 
allows HawkSoft users to skip the opt-in process for individual phone numbers. This is helpful if your 

agency collects opt-ins through another method and certain clients have already given their permission 

to receive text messages.

Accept legal liability on behalf of my agency and disable the automatic opt-in process - This 
option removes the opt-in process for all client files.

You can change your selection at any time by returning to Marketplace. 

 1.  Click the   Settings icon, and then select  Marketplace.

 2.  Scroll down to the Text Messaging section.

 3.   Click Manage, and then click Next to change your Opt-in selection.

 4.  Click Save.

Each user must restart CMS for the new opt-in workflow to take effect.

Regardless of which method you select, if a client opts out of text messages by sending "Stop," you are 

required to complete the HawkSoft opt-in process and receive a "yes" in reply to resume text com-

munication.
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To send an opt-in request

If Automatic Opt-In is enabled,  HawkSoft CMS will not allow you to send an outgoing text message until 

the client has opted in for text messages. 

The opt-in request is sent as a text message. Once a client replies with "Yes," they will be opted in and 

ready to receive future texts.

Send an opt-in request from the Action menu

HawkSoft recommends using the Action menu to send the initial opt-in request, to create a log note. 

 1.  Retrieve the client file, and then select the Client tab.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Send Text Message.
The Text Message Recipients dialog opens to display all cell phone numbers associated with 
the client file, as well as their opt-in status. 

 4.  Select one or more phone numbers by checking the box next to the number, and then click Send 
Opt In. The opt-in status for each phone number will change to Pending.

If your agency does not require automatic opt-in, you will see the option to 
skip sending this message.

 5.  Click Finish on the Text Message Recipients dialog.

 6.  Click  Finish on the Action menu.

HawkSoft creates a log note to document the opt-in request.

Send an opt-in request from a texting view

 1.  Select a phone number from the side-bar of the Client Texts, My Texts, or Unmatched Texts 

view.

 2.  Click Send Opt-In Text. 

If your agency does not require automatic opt in, you will see the option to 
skip sending this message.

Action Menu.htm
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Once the opt-in request is sent, it remains Pending until the client accepts.

Once the client replies "Yes" to the automatic opt in message, you can begin sending text messages.

Clients can opt out of text messaging anytime by texting "Stop."

To verify client Opt-In Status
You can verify the client's opt-in status from a few places in CMS:

 l Click the  icon on the Text Messaging dialog, to view the client's Opt-In Status at any time. 

 l View the status  from the Text Message Recipients dialog when using the Action menu to ini-
tiate a text.
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 l Click on the Cell Phone link on the client file to open the  Contact Information dialog.

To manually Opt Out a phone number
Clients can automatically opt out of text messaging anytime by texting "Stop." In addition, if a client 

expresses verbally or otherwise that they do not wish to receive text messages from your agency, you 

can manually opt out their phone number.

 1.  Retrieve the client file, and then select the Client tab.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 
this transaction. 

 3.  Select Change Client.
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 4.  Select a phone number within the Contact Info box, and then click Edit.

 5.  Click Opt Out Phone Number. 

A confirmation message appears.

If you wish to send a text message to the client in the future, you will have to initiate the opt in process. 

To resend Opt-In Texts
Occasionally you might need to resend the opt-in message to a client. Some agencies might want to 

renew opt-in statuses yearly, or a client might acquire a different phone number.

 1.  Retrieve the client file, and then select the Client tab.

 2.  Click on Client Texts.

 3.  Click on the   icon in the right-hand corner of the Texting window, then select Opt-In Status.

A message appears  confirming the number has already been opted in. 

 4.  Click Send Opt-In Text.

HawkSoft will not allow any outgoing text messages to the client's number until they have replied 

"Yes" to the opt in text message.

Related Topics
About HawkSoft Text Messaging
Text Message Notifications
Purchasing HawkSoft Text Messaging
Viewing & Sending Text Messages

Viewing & Sending Text Messages

HawkSoft makes it easy to view client text messages and send replies from a variety of locations within 

CMS. Available views and options depend on your texting permissions.

This topic is applicable to the built in HawkSoft Text Messaging feature. See About HawkSoft Text Mes-

saging to learn how to register and configure this feature.

#Resending_Opt_In_Texts
#Permissions


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1285

As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to anemail-to-text messagingservice provider and send text 
messages directly from a client file. This feature enables you to use your existing 
mobile number.

SeeText Messaging Overviewfor more information.

In this topic:

View a Text Message Text Message Information Send a Text Message

Watching a Conversation Archived Phone Numbers 

and Profiles

 

To view a text message

There are several options within HawkSoft CMS where you can view and reply to texts. 

Required Permissions:
To perform this task, no specific CMS user permissions are required. 

Text Message View Accessibility & Contents

Client Texts

Accessible from the toolbar while viewing the client's file. Clicking on a 

popup text notification will also bring you to the Client Texts  view if you 

are on that client file.

This view shows  the texts only for a particular client. You can also  ini-

tiate the opt-in process from this screen. If you have permissions to 

access the  client's file, you can view the entire text history from this win-

dow, even if you do not have permissions to send text messages.

My Texts

Accessible from the HawkSoft CMS menu bar and the "My Text" link on 

the left side-bar of CMS. 

Displays all conversations that have unprocessed text messages on any 

client file which has you listed as a CSR or Producer, or for clients you 

#View_a_Text_Message
#Text_Message_Information
#Send_a_Text_Message
#Watching_a_Conversation
#Archived_Phone_Numbers_and_Profiles
#Archived_Phone_Numbers_and_Profiles
#Following_Client_Texts:
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choose to follow.

Unmatched Texts

Accessible from the "Unmatched Texts" link on the left side-bar of CMS.

Displays all text messages received from phone numbers not found 

within HawkSoft CMS. SeeUnmatched Texts for more information.

All Unprocessed Texts

Viewable by Texting Administrators only. 

Displays all conversations for your agency that are not yet marked as 

processed. See Processing Text Messages for more information.

Text message information

Hover your mouse near a text message and click the   down arrow icon to view more information 

about a text message, including the client file(s) the phone number is matched to, date and time the 

message was received, and whether or not the message has been processed. 

If the text message contains an image, additional options for processing the image appear.

Helpful Tip

Be sure to select Cell Phone when entering a cell phone number on the Contact Information for your cli-

ents. Other phone types will not appear as options for text messaging.  

#Following_Client_Texts:
#Permissions
#Processing_attachments
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To send a text message

Required Permissions:
In order to complete this task, user permissions must be set to include:

Client File > Allow Sending Text Messages 

See Setting User Permissions for more information.

We recommend the following workflow for texting to simplify processing and minimize E&O exposure: 

 To learn how to text an ID Card to the Insured, see Auto ID Card or State Specific ID Cards.

 1.  Retrieve the client file, and then select the policy if needed.

You will be able to insert data from the selected client or policy when composing the text mes-

sage.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Send Text Message.

 4.  Select the recipient(s) from the Text Message Recipients dialog, and then click OK.

If the client has not yet opted in to receive text messages, you will need to send an opt-in request 

before contacting the client via text message.

To send the initial opt-in message
 a.  Retrieve the client file, and then select the Client tab.

 b.  Click Action, and then select one item in each of the first three lists to describe what promp-

ted this transaction.

 c.  Select Send Text Message.
The Text Message Recipients dialog opens to display all cell phone numbers associated 
with the client file, as well as their opt-in status. 

 d.  Select one or more phone numbers by checking the box next to the number, and then click 

Send Opt In. The opt-in status for each phone number will change to Pending.

../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
#Auto%20ID%20Card_..70
#State%20Specific%20ID%20Cards_..72
Action Menu.htm
Action Menu.htm
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If your agency does not require automatic opt-in, you will see the option to skip sending 

this message.

 e.  Click Finish on the Text Message Recipients dialog.

 f.  Click  Finish on the Action menu.

HawkSoft creates a log note to document the opt-in request. 

It is also possible to send an opt-in request from a texting view. See Text Messaging Opt-In Com-

pliance for more information.

 5.   Select a template to begin the conversation or select No Template and click OK. 

When using a template that contains policy level merge fields such as the 
Company Name or Policy Number, be sure to select a policy. See Text Mes-
sage Templates for information on setting up a template.

 6.  Compose your message and click Send. 

Optional: Click Insert Field to include information from the selected client or policy.

We suggest keeping text messages under 160 characters to prevent the mes-
sage from being divided into multiple texts, which can cause confusion.

 7.  Click Finish on the Action menu.

The Add Log Entry Comments dialog opens.

 8.  Add comments as needed, and then click OK.

Your text message is documented in the log note.

Moving forward, you can copy and paste the entire conversation in an appen-
ded log note. 

Append the Log Note with additional messages

Once you have finished exchanging text messages with the client for one conversation, 

you can copy and paste the remaining text messages into an appended  log note.

 1.  Hover your mouse to the   left of the first text in the conversation, and then select the 

box that appears.

#Text%20Message%20Templates
#Text%20Message%20Templates
#Text%20Message%20Templates
Creating a Log Note.htm
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 2.  Select the box next to the last text in the conversation. 

 3.  Click Copy Text to Clipboard at the top of the Texting window.

A message appears confirming that all texts between your two selections will be 

copied.

 4.  Click OK.

For E&O purposes, HawkSoft will not allow you to skip messages 

between the beginning and end of your selection. 

 l To copy a conversation, select the first and last message, and 

then click Copy Text to Clipboard.

 l To copy only one text, rather than a conversation, simply select 

one check box. 

 5.  Return to the client file and right-click on the original log note, and then select 

Append Log.

 6.  Press Ctrl-V on your keyboard to paste the text conversation into the log note or 
right-click and select Paste.

See Processing Text Messages and Appending a Log Note for more information.

Watching a conversation

When you are actively texting with a client, you will likely keep the client texting window open. When 

this occurs, HawkSoft considers you to be "watching" the conversation and will mute notifications for 

other users following the client. This prevents fellow users from receiving a rapid secession of noti-

fications as the client replies to you, and prevents other users from replying to the client at the same 

time.

However, if another user opens the Client Texting view for that client, they will receive notifications.

Be sure to close the Client Texting view when you are ready for other users to receive notifications of 

the client's replies.

../../../../../Content/Log Notes/Appending a Log Note.htm
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Archived phone numbers and profiles

If you remove a phone number  or archive a profile from the client file, the text messaging history for the 

number will continue to display within the Client Texts view with a note that "This profile is archived." 

Users will not be able to send text messages to the phone number from that client file. 

New messages from the number will not display - they will be sent to the Unmatched Texts view or to 

any other client file the number is associated with. 

Related Topics 
Auto ID Card
Processing Text Messages
State Specific ID Cards
About HawkSoft Text Messaging
Text Message Notifications
Text Messaging Opt-In Compliance
Purchasing HawkSoft Text Messaging
Unmatched Texts

Processing Text Messages

A text message is considered processed once appropriate action is taken on the client/policy and the  

conversation has been added to a log note. 

This guide covers the recommended workflow for processing text messages using the built-in 

HawkSoft Text Messaging tool. 

As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to an  email-to-text messaging service provider and send text 
messages directly from a client file. This feature enables you to use your existing 
mobile number.

See Text Messaging Overview for more information.

You can process text messages from any texting view: Client Texts, My Texts, Unmatched Texts, All 

Unprocessed Texts. See Viewing & Sending Text Messages for more information.

We do not recommend processing unmatched text messages until they have been associated with a 

client file. See Unmatched Texts for more information.

#Auto%20ID%20Card_..70
#State%20Specific%20ID%20Cards_..72
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HawkSoft keeps a record of each client's full texting history, including processed and unprocessed text 

messages, within the Client Text window.

In this topic:

Suggested Workflow for Pro-

cessing Text Messages

Copying Text Messages to 

your Clipboard

Adding Text Messages to a 

Log Note

Saving Text Messages to 

PDF

Processing Attachments Marking Text Messages as 

Processed

Required Permissions:
In order to complete this task, user permissions must be set to include:

Client File > Access to Client Types (You must have permission to the Client Type 
you want to access.) > Action Menu

See Setting User Permissions for more information.

Suggested workflow for processing text messages

HawkSoft keeps a record of each client's full texting history within the Client Text window. 

HawkSoft recommends that you copy and paste text messages into a log note and/or attach a PDF of 

the conversation to a log note  for the following reasons: 

 l Record an action or policy change that resulted from the text message

 l Provide context for the conversation and maintain E&O accountability

 l Enable log notes containing text messages to be exported, should an agency leave HawkSoft 

CMS (the full text log found within the Client Texts window is not available for export.)

After saving the log note, you can mark the corresponding texts as processed using the steps below.

Copying text messages to your clipboard

 1.  Open a text messaging view, click to the left of the first text in the conversation, and then select 

the check box that appears.

#Suggested_Workflow_for_Processing_Text_Messages
#Suggested_Workflow_for_Processing_Text_Messages
#Copying_Text_Messages_to_your_Clipboard
#Copying_Text_Messages_to_your_Clipboard
#Adding_Text_Messages_to_A_Log_Note
#Adding_Text_Messages_to_A_Log_Note
#Saving_Text_Messages_to_PDF
#Saving_Text_Messages_to_PDF
#Processing_attachments
#Marking_Text_Messages_as_Proccessed
#Marking_Text_Messages_as_Proccessed
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 2.  Select the check box next to the last text in the conversation. 

 3.  Click Copy Text to Clipboard.
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 For E&O purposes, HawkSoft will not allow you to skip messages between the 

beginning and end of your selection. 

 l To copy a conversation, select the first and last message, and then click 

Copy Text to Clipboard.

 l To copy only one text, rather than a conversation, simply select one check 

box. 

 4.  Click OK.

Adding Text Messages to a log note
Once you have copied the text messages to your clipboard, return to the client file.

 1.  Click Action, and then select one item in each of the first three lists to describe what prompted 
this transaction. 

 2.  Select an action to perform or select Log from the fourth list on the Action menu.

The Add Log Entry Comments dialog opens with the date and time, username, and the Action 
menu thread that created the log.

 3.  Right-click in the Add Log Entry Comments dialog, and then select Paste. 

 4.  The selected text messages appear in the log note, as well as which agent was texting, text num-

bers used, and the time and date of the text messages.
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 5.  Add comments as needed, and then click OK to save the log note.

Append the log note with additional messages

Once you have finished exchanging text messages with the client for one conversation, 

you can copy and paste the remaining text messages into an appended  log note.

 1.  Hover your mouse to the   left of the first text in the conversation, and then select the 

box that appears.

 2.  Select the box next to the last text in the conversation. 

 3.  Click Copy Text to Clipboard at the top of the Texting window.

A message appears confirming that all texts between your two selections will be 

copied.

 4.  Click OK.
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For E&O purposes, HawkSoft will not allow you to skip messages 

between the beginning and end of your selection. 

 l To copy a conversation, select the first and last message, and 

then click Copy Text to Clipboard.

 l To copy only one text, rather than a conversation, simply select 

one check box. 

 5.  Return to the client file and right-click on the original log note, and then select 

Append Log.

 6.  Press Ctrl-V on your keyboard to paste the text conversation into the log note or 
right-click and select Paste.

Saving text messages to PDF
HawkSoft can generate a PDF file from selected text messages to create a record of the conversation. 

This PDF file can be copied to your clipboard or attached to a log note using the HawkSoft Virtual 

printer. 
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The PDF method can be done in addition to or instead of copying and pasting the text into a log note.

 1.  Open a texting view, click to the left of the first text in the conversation, and then select the check 

box that appears.

 2.  Select the check box next to the last text in the conversation. 

For E&O purposes, HawkSoft will not allow you to skip messages between the 

beginning and end of your selection. 

 l To copy a conversation, select the first and last message, and then click 

Create PDF.

 l To create a PDF of only one text, rather than a conversation, simply select 

one check box. 



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1297

 3.  Click Create PDF and select one of the two options from the drop-down menu:

Copy to Clipboard - Creates a temporary PDF file which is saved on your computer's clip-
board. You can paste this file to your computer or into another program.

Attach to CMS - launches the HawkSoft Virtual Printer, enabling you to add additional 
information about the PDF file. The PDF will be attached to the client file.

If you select the "Use Action Menu" check box from the HawkSoft Virtual Printer, a log note 

will be created. As the content of the selected text messages is also copied to your clip-

board, you can paste the text messages into the log note if you wish.

Processing attachments
Incoming text messages that contain attachments are designated with a paperclip icon. Hover your 

mouse near the message and click the   down arrow to preview the attachment, view details about 

the message, and access available options for saving and processing the file.

#The%20HawkSoft%20Virtual%20Printer
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Expand the message via the    down arrow icon  and select one of the following options:

 l Drag and drop the attachment directly into the client's file

 l View the attachment in an external window

 l Download the attachment to your computer

 l Copy the attachment to your clipboard

 l Attach the document to the client's file within HawkSoft CMS. 

Selecting to attach the document to the client's file launches the HawkSoft Virtual Printer, 

enabling you to attach the image to the client or a specific policy with additional information.

Once you've finished with the file, mark the text as processed.

Marking text messages as processed
Once you have taken any needed action on the client/policy and a log note from the conversation has 

been saved to the client file,  return to the Texting window to mark the text messages as processed. 

#The%20HawkSoft%20Virtual%20Printer


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1299

 1.  Open a texting view.

 2.  Select the check boxes on the left-hand side of the messages you want to process, and then 

click Mark Processed at the top of the Texting dialog. 

OR If all unprocessed texts are already recorded into a log note, you can click Mark All Pro-
cessed.

Once processed, text messages are removed from the My Texts and All Unprocessed Texts views 
and text message counts. The text messages will always remain in the Client Texts window.

Related Topics 
About HawkSoft Text Messaging
Text Message Notifications
Text Messaging Opt-In Compliance
Purchasing HawkSoft Text Messaging
Viewing & Sending Text Messages

Unmatched Texts

When your agency receives a text message from a number that does not match a cell number in a cli-

ent file,  the text is sent to the Unmatched Texts. 

Your agency should monitor Unmatched texts and determine the identity of the texter so that their 

phone number can be added to the appropriate  client file.

This topic explains how to match texts to a client file when using the HawkSoft Text Messaging feature.

As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to an  email-to-text messaging service provider and send text 
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messages directly from a client file. This feature enables you to use your existing 
mobile number.

See Text Messaging Overview for more information.

Matching texts to a client file

 1.  Establish the identity of the person sending the text. Since you are not able to reply to the num-

ber with a text message (unless they have opted in), the quickest method is likely to call the num-

ber.

 2.  Open the corresponding client file and use the Action button add the mobile number. Altern-
atively, if the individual does not yet have a client file, create one and add the number to the new 

file.

 3.  Return to the Unmatched Text message for the client and click Refresh Client Data.

 4.  If HawkSoft is able to match the phone number to a client file, the conversation will update with 

the matched client info but stay in Unmatched view until you exit the view. All text messages will 

now be associated with the client's file and appear in that client's Client Text view.

 5.   Close the Unmatched Texts view. You may process the texts from the Client Texts view. See 

Processing Text Messages for more information.

 If you send a text message immediately after adding or updating a client file, the 
text message might temporarily appear in the Unmatched view. Wait a few minutes 
for the data to sync between HawkSoft CMS and HawkSoft Data Syncing, then 
click Refresh Client Data. The issue should resolve.

#Insert%20a%20Prospect:%20Sales%20Pipeline_..36
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Related Topics 

Processing Text Messages

About HawkSoft Text Messaging

Text Message Notifications

Text Messaging Opt-In Compliance

Viewing & Sending Text Messages

Text Message Notifications

HawkSoft CMS keeps your team updated on incoming text messages through real-time notifications 

and text counts.

This article explains how texting notifications work.

In this topic:

Notifications Total Number of Unpro-

cessed Text Messages

Follow a Client's Text Mes-

sages

Mute Notifications Watching a Conversation  

As an alternative to using the built in HawkSoft Text Messaging feature, your 
agency can subscribe to an  email-to-text messaging service provider and send text 
messages directly from a client file. This feature enables you to use your existing 
mobile number.

See Text Messaging Overview for more information.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Search and Client Access > Access to Client Types > Access to Customer Types

See Setting User Permissions for more information.

#Total_Number_of_Unprocessed_Text_Messages
#Total_Number_of_Unprocessed_Text_Messages
#Following_Client_Texts:
#Following_Client_Texts:
#Mute_Notifications
#Watching_a_Conversation
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Notifications 

Text message notifications are triggered for:

 l Clients for which you are listed as a policy CSR or producer

 l  Clients you choose to follow

 l Any unmatched text messages

Notifications appear as pop-ups on the bottom of your Window's screen and remain for a few seconds 

before disappearing. You must have notifications enabled from within your User Preferences panel for 

these to appear.

The notification's sound is determined by your Windows setting.

You can click  on a notification to launch the text in one of the following windows:

 l My Texts window with the most recent text message at the top of the queue 

 l Client Texts window if you are currently viewing that client

 l Unmatched Texts window if the notification is for an unmatched number

Total number of unprocessed text messages

The My Texts icon   displays the number of unprocessed text conversations  at the top of the 

HawkSoft CMS menu bar and next to the My Texts link on the left CMS side-bar. Text counts are 
updated every 60 seconds.

The text count will remain until you've marked text messages as processed. See our guide on Pro-

cessing Text Messages for more information.

If you are a Texting Administrator, you will also see text counts accumulate next to the All Unpro-
cessed Texts link on the left side-bar of HawkSoft CMS.

#Following_Client_Texts:
#User%20Preferences
#Permissions
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When you are actively texting with a client, you will likely keep the client texts win-
dow open. When this occurs, HawkSoft considers you to be "watching" the con-
versation and will mute notifications for other users following the client. 

This prevents fellow users from receiving a rapid secession of notifications as the 
client replies to you, and prevents other users from replying to the client at the same 
time. 

Be sure to close the client texting view when you are ready for other users to 
receive notifications of the client's replies.

To follow a client's text messages
If you want to stay updated on texts from clients for which you are not listed as a CSR or Producer, you 

can "follow" the client and receive text notifications.

You must have User Permissions to the client file to follow the text messages.

 1.  Open a client file.

 2.  Click Client Texts from the toolbar.

 3.  Check the Follow Client box in the top left of the text message window.

Future text messages from that client will appear in  your My Texts view, and also appear  as  pop-up 
notifications.

Multiple HawkSoft users can follow the same  client. The client's texts will appear in  each individual’s 

My Texts view.

If you are listed as a producer or CSR on a client’s policy, you cannot unfollow the 
client file text messages.

To mute notifications
You can temporarily mute pop-up notifications using the drop-down next to your user name. 

 1.  Click on your user name at the top-right of the HawkSoft CMS window.

 2.  Select Mute Notifications and your desired mute period.

User Permissions.htm
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A muted icon   appears at the top of the CMS window until the muted time selected is over, or until 

you click the icon to end the mute early. 

Texting counts will still update as normal while notifications are muted.

Watching a conversation

When you are actively texting with a client, you will likely keep the client texting window open. When 

this occurs, HawkSoft considers you to be "watching" the conversation and will mute notifications for 

other users following the client. This prevents fellow users from receiving a rapid secession of noti-

fications as the client replies to you, and prevents other users from replying to the client at the same 

time.

However, if another user opens the Client Texting view for that client, they will receive notifications.

Be sure to close the Client Texting view when you are ready for other users to receive notifications of 

the client's replies.

Related Topics 

About HawkSoft Text Messaging

Text Messaging Opt-In Compliance

Purchasing HawkSoft Text Messaging

Viewing & Sending Text Messages
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Text Messaging with Email-to-SMS Services

HawkSoft CMS users who subscribe to a supported Email-to-SMS service and have completed Text 

Messaging Setup in CMS can send messages directly from a client file to a client's cell phone number. 

This guide is for email-to-SMS texting integrations. For information about HawkSoft's built-in text mes-

saging feature, see About HawkSoft Text Messaging.

See Text Messaging Setup (Email-to-text) for detailed steps to configure text messaging for each user. 

Text messages are limited to 160 characters. Messages exceeding this limit may be cut off, or sent as 

separate messages by the SMS provider. 

In this topic:

Creating and Sending a Text 

Message using the Action 

Menu

Creating and Sending a Text 

Message using the Client 

View Screen

Required Permissions:
In order to complete this task, user permissions must be set to include:

Client File > Action Menu > Allow Sending Text Messages

See Setting User Permissions for more information.

Creating and sending a text message using the Action menu

 1.  Retrieve the client file, and then select the Client tab or a policy within the file.

 When using a template that contains policy level merge fields such as the 
Company Name or Policy Number, be sure to select a policy. See Text Mes-
sage Templates for information on setting up a template.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Send Text Message.

../../../../../Content/User Setup/Text Messaging Setup Email to Text.htm
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#Creating_and_sending_a_Text_Message_from_the_Client_View_screen
#Creating_and_sending_a_Text_Message_from_the_Client_View_screen
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The Text Message Recipients dialog displays cell phone numbers that have been entered on 
the Client Name and Address Information screen for the selected client.

 4.  Select the cell phone number(s) for this message, and then click OK.

OR

To proceed without selecting a cell phone number, click Skip. This option allows you to manually 
enter a cell phone number in the Send Text Message (SMS) dialog. 

If you have one or more Text Message Templates saved, the Select Text 
Message (SMS) Template dialog opens. Select a text message template, or 
**No Template**, and then click OK.

See Text Message Templates for more information.

The Send Text Message (SMS) dialog opens.

 5.  Edit the message as needed, and then click Send.

 If the phone number was skipped in step 4, enter it in the To field. 

 6.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog box opens.

 7.  Add comments as needed, and then click OK.

Your text message is sent and a log note is created to document the text message in the client file.

Creating and sending a text message from the Client View 

screen

 1.  Retrieve the client file, and then select the Client tab or a policy within the file.

When using a template that contains policy level merge fields, such as the 
Company Name or Policy Number, be sure to select a policy. See Text Mes-
sage Templates for information on setting up a template.

 2.  Click the underlined Cell Phone link in the Client Information pane of the client file view.

The Contact Information dialog opens.

#Client%20Name%20and%20Address%20Information
#Text%20Message%20Templates
../../../../../Content/Log Notes/Add Log Entry Comments CSH.htm
#Text%20Message%20Templates
#Text%20Message%20Templates
#Tour%20of%20the%20Client%20File
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Only the first few contact numbers or email addresses may be visible from 
the Client Information pane. To view additional contact information, click the 
More link.

 3.  Select the cell phone number for this message, and then click  Send Text.

 If you have one or more Text Message Templates saved, the Select Text 
Message (SMS) Template dialog opens. Select a text message template, or 
**No Template**, and then click OK.

See Text Message Templates for more information.

The Send Text Message (SMS) dialog opens.

 4.  Edit the message, as needed, and then click Send.

 5.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog box opens.

 6.  Add comments as needed, and then click OK.

 7.  Click Close to exit the Contact Information dialog.

Your text message is sent and a log note is created, documenting the text message in the client file.

Troubleshooting
The following error message has been encountered by new MessageMedia users:

"The messaging gateway could not process your request"

This error is typically a result of MessageMedia not having the user’s email whitelisted in their system.

Contact MessageMedia at (866)751-8337 to work with them to whitelist the email address for the user 

profile in question.

Related Topics
Text Messaging Overview
Text Message Templates
Text Messaging Setup

#Text%20Message%20Templates
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Form Letters
HawkSoft CMS enables you to  merge client and policy information from the client file into a letter, 

modify the letter as needed, and attach a copy for documentation purposes. 

Once a letter  is attached to the client file, you can perform actions from the Attachments List, such as 

emailing the letter or sending the letter for an electronic signature.

This article explains how to create and edit a letter from a client file using a previously created form let-

ter template. 

See Form Letter Templates  for information on creating templates using the HawkSoft CMS Letter 

editor.

See Batch Mailing (Print) for information on creating and sending a form letter to a list of clients.

See Microsoft Word Form Letters for letters created using Microsoft Word.

In this topic:

Creating a Form Letter Editing a Saved Copy

Required Permissions:
In order to complete this task, user permissions must be set to include:

Client File > Action Menu

See Setting User Permissions for more information.

Creating  a form letter

 1.  Retrieve a client file, and then select the Client tab or a policy within that file.

When using a template that contains policy level merge fields 
such as the Company Name or Policy Number, be sure to select 
a policy, not the Client tab.

#Form%20Letter%20Templates
#Creating_a_Form_Letter
#Editing_a_Saved_Copy
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 2.  Click Action, and then select one item in each of the first three lists to describe what 

prompted this transaction.

 3.  Select Print/Create > Letter. 

The Form Letter dialog opens.

 4.  Select a letter template.

Use the Select Category drop-down to filter the template list.

 5.  Click OK.

A preview of the letter displays in the CMS Letter Editor.

 6.  Modify the letter, as needed.

See Modifying Correspondence to learn about available editing options.

 7.  Optional: Save an editable copy to the Attachments List that can be opened and 

modified in the future. 

Click File, and then check Save Editable Copy On Close.

When the letter is printed or attached, an editable copy as well as a PDF are saved 

to the client file..  

Once a user selects Save Editable Copy On Close, that fea-
ture is enabled for all future letters and memos. Uncheck this 
option to turn  this setting off for future letters.

 8.  Use the File menu to print and/or attach the letter.

Print and Close – Select to print the letter. A PDF of the letter is attached to the log 
note and client file.

The Print dialog opens. Modify settings as needed, and then click Print.

Attach and Close – Select to attach a PDF to the log note and client file without 
printing.

 9.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog opens.

 10.  Add comments as needed, and then click OK.

Action Menu.htm
../../../../../Content/Log Notes/Add Log Entry Comments CSH.htm
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The letter is attached to the client file as a PDF and can be accessed from within the log 

note or from the Attachments tab.  If  Save Editable Copy on Close was selected, a 
second copy that can be edited, is also attached. 

See Working with Attached Documents Overview to perform actions from the Attachments 

List, such as emailing the letter or sending the letter for an electronic signature.

Editing  a saved copy
When an editable copy of the letter is saved and attached to the Attachments list, the letter 

can be modified and saved as a new attachment. 

 1.  Retrieve the client file, and then select the appropriate policy, or the Client tab.

 2.  Select the Attachments tab.

 3.  Locate the editable copy of the letter.

The Attachment Type column identifies the editable copy as a  Letter. The PDF ver-
sion is identified as an Adobe Acrobat Document.

 4.  Double-click the editable copy.

The letter opens in the CMS Letter Editor.

 5.  Edit the letter, as needed.

See Modifying Correspondence (Letters, Memos,  Proposals, and Policy Overview)  

to learn about available editing options.

 6.  Use the File menu to print and/or attach the letter.

Print and Close – Select to print the letter. A PDF of the letter is attached to the log 
note and client file.

The Print dialog opens. Modify settings as needed, and then click Print.

Attach and Close – Select to attach a PDF to the log note and client file without 
printing.

 7.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog opens.

 8.  Add comments as needed, and then click OK.

#Working%20with%20Attached%20Documents%20Overview
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The modified letter is attached to the client file as a PDF. The original  copy is still attached 

for future modifications.  See Working with Attached Documents Overview to perform 

actions from the Attachments List, such as emailing the letter or sending the letter for an 

electronic signature. 

Related Topics

Communications Overview
Form Letter Templates
Microsoft Word Form Letters
Modifying Correspondence (Letters, Memos,  Proposals, and Policy Overview)
Working with Word Documents

Microsoft Word Form Letters

This article explains how to edit form letters created in HawkSoft CMS, prior to version 3.04 and using 

Microsoft Word®.

This article does not apply to form letters created using the CMS Letter Editor.

See Form Letters and  Modifying Correspondence (Letters, Memos,  Proposals, and 
Policy Overview) for more information.

In this topic:

Editing a Microsoft Form Let-

ter

Adding a Merge Field Deleting Unwanted Merge 

Fields

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Letter/Email/Proposal Templates

See Setting User Permissions for more information.

#Working%20with%20Attached%20Documents%20Overview
#Form%20Letter%20Templates
#Working%20with%20Word%20Documents
#Editing_a_Microsoft_Word_from_Letter
#Editing_a_Microsoft_Word_from_Letter
#Adding_a_Merge_Field
#Deleting_Unwanted_Merge_Fields
#Deleting_Unwanted_Merge_Fields
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CMS supports form letter integration with Microsoft (MS) Word  2007, 2010, 2013, and 2016 "Pro-

fessional" or "Home & Business". CMS does not support integration with MS Word  academic versions, 

or any versions of MS Word older than 2007.

Editing a Microsoft Word form letter

 1.  Click the   Settings icon, and then select Correspondence Templates.

The Correspondence Templates dialog opens with  the Form Letters tab open.

 2.  Select the form letter you want to modify, and then click Edit.

 3.  MS Word launches the selected form letter.

 4.  Edit the letter as needed (see below).

 5.  When finished, Save the letter and close it.

Exact steps vary depending on the version of MS Word being used. 
Please refer to MS Word's Help instructions for steps specific to your 
version of Word.

Adding a merge field

 Place your cursor where  the merge field should appear, and then click Insert Merge 
Field (a menu item or toolbar icon, depending on your version of Word).

See Merge Field Descriptions for definitions of each available merge field.

Formatting a merge field

 1.  Select the entire merge field, including the chevrons << >>.

 2.  Right-click the highlighted field to access  menu options for formatting.

 3.  Format the merge fields as desired, including punctuation and spacing.

Inserting user input fields

A user input field provides a way to insert information into a form letter that 

cannot be merged from CMS. For instance, if a client needs to relay inform-

ation by a specific date for underwriting purposes, add a Need By user input 
field. When  the letter is opened for printing, the user is prompted to insert the 

information before printing the letter.
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 1.  Place your cursor where the input field should appear, and then:

 l For MS Word 2003, click Insert Word Field on the toolbar, and 
then select Fill-in.

 l For MS Word 2007 and later, click the Mailings tab, click Rules, 
and then select Fill-in.

Exact steps vary depending on the version of 
MS Word being used. Please refer to MS Word's 
Help instructions for steps specific to your version of 
Word.

 2.  In the Prompt box, type a description of what the user will need to 
insert, for example, a Need By date.

This prompt tells the user what information is needed to complete the 

letter.

The Default fill-in text box is generally not used because it will auto-
matically populate the field, rather than allow the user to enter the 

required information.

 3.  Finish adding the field according to MS Word's instructions.

Deleting unwanted merge fields

Select the entire field, including chevrons << >>, and then press the Delete key.

Related Articles
Form Letter Templates
Merge Field Descriptions

Batch Mailing (Print)

HawkSoft CMS batch mailing enables your agency to send the same letter to all (or selected) clients 

from a report.   

For example, you might want to create a Renewal Letter to all insureds renewing next month, or a 

Cancel Letter to all insureds who canceled last month.

#Form%20Letter%20Templates
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If you have not already done so, create a template for your form letter. See instructions in the Form Let-

ter Templates article.

In this topic:

Reports Printing Letters Printing Labels

Required Permissions:
In order to complete this task, user permissions must be set to include:

Reports > Advanced Reports > Sales & Retention (optional) > Create New Reports 
(if needed)

See Setting User Permissions for more information.

Reports
You can use the batch mailing feature with any of the following CMS reports:

Advanced Customized Reports

Agency Intelligence Reports 

Sales and Retention Reports

Helpful hints for creating a customized Advanced 

report to generate  batch mailings

 l Select Report By > Client (At least one policy must match 
criteria). This setting will minimize duplication of client files.

 l Add reporting fields for any merge field  used in your intended form let-
ter. This will be helpful to determine clients and policies with missing 

information while reviewing the report and prior to printing the form let-

ter.

 l Sort the report by clicking on the column headers to look for any 
empty fields.

#Form%20Letter%20Templates
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#Printing_Labels
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 l Reduce the number of letter recipients by summarizing the report, 
for example by line of business, and then double-click on the group you 

are sending the letter to. Then batch print the letters from the sum-

marized report.

See Working with Report Data for information on summarizing the 

report.

Helpful hints for batch mailing from an Agency Intel-

ligence or Sales & Retention report

 l Select a predefined report

For example: Sales & Retention report:  No Active Auto, to target cus-

tomers renewing in the next 60 days.

 l Double-click in the  cell with the customer count to drill-down to the cus-
tomer information you need for creating the batch mailing.

 l Reduce the number of letter recipients by summarizing the report, 
for example by line of business, and then double-click on the group you 

are sending the letter to. Then batch print the letters from the sum-

marized report.

See Working with Report Data for information on summarizing the 

report.

Printing letters

 1.  Once your letter template and report are created, open the report to select the cli-

ents you want to send letters to.

 l To select the entire report:

Click File > Print > Form Letters.

 l To select specific items:

#Working%20with%20Report%20Data
#Working%20with%20Report%20Data
#Form%20Letter%20Templates
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 a.  Press and hold the Ctrl key and select specific entries. 

OR

To select a range of line items, select the first item, and then press the 

Shift key to select the last item to be included. 

 b.  Click File > Print > Form Letters.

 2.  Complete the Print Form Letters dialog. 

 a.  Form Letter – Select the letter template that you want to print from the  drop-
down list.

 b.  Print Form Letter for – This setting defaults depending on the selection 
made in step 1. 

 l Defaults to All, if you did not select specific items

 l  Defaults to Selected Item(s) if you selected specific line items 

 c.  Optional: Click Preview if the selected letter is a CMS form letter, to view the 
first fifty letters prior to printing.

 d.  Optional: Check Create log entry on each client printed if you would like to 
create a log entry  for each client receiving the letter.

 l Enter text in the box provided.

 l Optional: Create a suspense for each log entry.

 e.  Click OK.

 3.  Print the batch of letters.

You can print all letters to a single PDF file by selecting the Vir-
tual Printer. This is useful when sending the letters to a 3rd party 
for printing.

 l CMS Form Letter –  If the selected letter was a CMS Form Letter, the Print 
dialog opens.

Select your printer, and then click Print.

Suspending a Log Note.htm
#The%20HawkSoft%20Virtual%20Printer
#The%20HawkSoft%20Virtual%20Printer
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A copy of the letter is attached to the client's log entry, if a 
log entry was created.

 l Microsoft Word Document –  If the selected letter was a Microsoft Word 
Document, Word will launch and display the merged letters.

Print according to your version of Microsoft Word.

A copy of the letter will not attach to the client's log entry.

Printing labels
For more information on downloading and customizing labels, see Mailing Labels.

 1.  Once your  report is created, open the report to display the list of those clients you 

want to print labels for.

 l To select the entire report:

Click File > Print > Form Letters.

 l To select specific items:

 a.  Use the Ctrl key to  select specific line items. 

OR

To select a range of line items, select the first item, and then press the 

Shift key to select the last item to be included in the section. 

 b.  Click File > Print > Form Letters.

 2.  Select the label template from the Form Letter drop-down menu.

 3.  Print labels for – This setting defaults depending on selection made in step 1. 

 l Defaults to All, if you did not select specific items

 l  Defaults to Selected Item(s) if you selected specific line items 

 4.  Optional: Create a log entry for each client printed, and suspend the log entry for fol-

low-up, if needed.

 5.  Click OK.

Suspending a Log Note.htm
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MS Word opens and displays  the data merged into the label template.

 6.  Click File > Print, and then follow on-screen prompts.

Related Topics
Advanced Customized Reports
Agency Intelligence Reports
Mailing Labels
Modifying Correspondence (Letters, Memos,  Proposals, and Policy Overview)
Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Overview)
Sales and Retention Reports
Working with Report Data

Mailing Labels

HawkSoft CMS has the ability to print mailing labels through CMS Agency Reports. Templates for the 

most commonly used labels, Avery 5160 and Avery 8160, come installed with CMS as of version 3.04. 

The label templates contain merge fields for client name and address information.

To verify whether label templates are installed, or have already been downloaded, click Setup > Cor-
respondence Templates from the main CMS menu bar. Mailing label templates are listed on the 
Form Letters tab.

In the event you need to download these templates, two versions are available from the download cen-

ter:

 l Avery 5160 or 8160 – Or Current Resident

(Appends the addressee field with Or Current Resident)

 l Avery 5160 or 8160

For instructions, see Mailing Labels, below.

Custom templates can be created for other labels as well.
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In this topic:

Customizing Avery 5160 or 8160 Labels Downloading Avery 5160 or 8160 Labels

Using Labels Other than Avery 5160 or 8160 

Labels

Printing Labels

Required Permissions:
In order to complete this task, user permissions must be set to include:

Reports > Advanced Reports (Optional: Agency Intelligence or Sales and Reten-
tion Reports) > Create New Reports

Reports > Output of Reports > Allow Exporting, Printing, and Saving of Reports 
(You can select Only Allow Printing of Form Letters, Envelopes, Invoices, and State-
ments instead, as this permission also works for the basic task of creating and print-
ing mailing labels.)

See Setting User Permissions for more information.

Microsoft Word® Integration must be enabled in General Settings in order to use 
label templates. Microsoft Word 2002 or newer must be installed on the computer 
used to generate labels.

Customizing Avery 5160 or 8160 labels

 1.  Click the   Settings icon, and then select Correspondence Templates.

Mailing label templates are located on the Form Letters tab.

 2.  Right-click on the Avery label template you want to edit, and then click Copy.

 3.  Right-click anywhere in the Title list, and then click Paste.

 4.  Right-click on the copy, and then click Rename.

 5.  Rename the template as needed, and then click OK.

#Customizing_Avery_5160_or_8160_Labels
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For example, Policy Renewal Mailing Labels.

 6.  Double-click the label template.

MS Word opens the template as a Word document.

 7.  Edit the template as needed.

Exact steps may vary depending on the version of MS Word 
being used. Refer to MS Word Help instructions for steps spe-
cific to your version of Word.

CMS merge fields are available in the MS Word Insert Merge 
Field drop-down list.

 8.  Save, and then close the document.

Downloading Avery 5160 or Avery 8160 labels

 1.  Visit the HawkSoft Download Center.

You can also visit http://download.hawksoftinc.com/ using your 
preferred web browser.

 2.  Enter labels (all lower-case) in both the Username and Password fields.

 3.  Click Submit.

The Save File dialog box opens.

 4.  Select one of the label templates, and then click Download File.

 5.  Optional: Change the file name, and then click Save.  

 6.  Click Close when the download is complete.

Using labels other than Avery 5160 or Avery 8160
For labels other than Avery 5160 or 8160 labels, you can create your own template in 

MS Word, and then add it to CMS. The CMS merge fields are then inserted in the template 

after it has been imported into CMS.

http://download.hawksoftinc.com/


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1321

Exact steps may vary, depending on the version of MS Word being 
used. Refer to MS Word Help instructions for steps specific to your ver-
sion of Word. 

 1.  Open a new blank Word document.

 2.  Create a new label template.

 3.  Click File > Save As, and then browse to [network drive]:\haw\letters folder.

 4.   Name the new template, using the default file extension, and then click Save.

For example, Holiday Mailing Labels.docx.

To determine the correct path, click the   Help icon, and then 
select  System Information from the main CMS toolbar. Note 
the path for the HAW folder.

The blank template is now installed in CMS.

 5.  Close the template file in MS Word.

 6.  Return to HawkSoft CMS.

 7.  Click Click the   Settings icon, and then select Correspondence Templates.

 8.  Locate the new label template, and then double-click to launch it in Word.

 9.  Click the Table Tools Layout ribbon, and then click View Gridlines so the label 
fields are visible.

HawkSoft, Inc. recommends using the Step-by-Step Mail Merge 
Wizard (found on the Mailings ribbon, under Start Mail 
Merge) to complete this process. See Microsoft Word Help for 
instructions.

 10.  Insert merge fields, and format the first label for final output, including font, size, spa-

cing, and punctuation.

CMS merge fields are available in the MS Word Insert Merge Field drop-down list.

 11.  Save and close the file.



3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1322

Printing labels

 1.  Click Reports from the main CMS menu bar, and then select a report to create the 
list of clients you are mailing to.

See Business Agency Reports Overview to determine which report to use.

If using Advanced Customized Reports, select Report By 
> Client (At least one policy must match criteria) when cre-
ating a mailing list report. This setting will minimize duplication of 
client files.

 2.  Optional: Select specific line items to generate labels for specific clients.

 3.  Click File > Print > Form Letters from the Report menu bar.

 4.  Select the label template from the Form Letter drop-down menu.

 5.  Select  All, Selected Items, or enter a Range of Items (line item numbers) to 
determine the labels to be printed.

 6.  Optional: Create a log entry for each client printed, and suspend the log entry for fol-

low-up, if needed.

 7.  Click OK.

MS Word opens and displays  the data merged into the label template.

 8.  Click File > Print, and then follow on-screen prompts.

Related Topics

Form Letters
Form Letter Templates
Microsoft Word Form Letters
Modifying Correspondence (Letters, Memos,  Proposals, and Policy Overview)
Advanced Customized Reports

DYMO Label Writer

Agencies can download a Microsoft Word® label template compatible with DYMO™ labels and then 

use it to print to a DYMO LabelWriter™. First, you must install the DYMO LabelWriter software. Please 

see the DYMO website for more information.

#Business%20Agency%20Reports%20Overview
#Advanced%20Customized%20Reports
Suspending a Log Note.htm
#Form%20Letter%20Templates
#Advanced%20Customized%20Reports
http://global.dymo.com/enUS/CampaignsHome/LabelWriter_Software_Integration.html
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In this topic:

Downloading the DYMO Label Template 

Creating a Custom DYMO LabelWriter Tem-

plate

Using he DYMO LabelWriter

In order for HawkSoft CMS to integrate with the DYMO LabelWriter, MS Word 
needs to be installed on the computer to which the DYMO LabelWriter is con-
nected. Please see HawkSoft CMS System Requirements for compatible versions 
of MS Word.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Form Letters

See Setting User Permissions for more information.

Downloading the DYMO Label template

 1.  Click Utilities > Download Center from the main CMS menu bar.

 2.  Type labels, using lower-case letters, in the Username and Password fields.

 3.  Click Login.

 4.  Click DYMO Label Template, and then click Download File. 

The Downloading File dialog box opens.

 5.  Click Close when the download is complete.

 6.  Click the X in the upper right corner of the Download Center dialog box to close it.

Creating a custom DYMO LabelWriter template

#Downloading_the_DYMO_Label_Template_Local
#Creating_a_Custom_DYMO_LabelWriter_Template
#Creating_a_Custom_DYMO_LabelWriter_Template
#Using_the_DYMO_LabelWriter
http://hawksoftinc.com/agency-management-system/system-requirements
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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 1.  Click   Settings > Correspondence from the main CMS menu bar.

 2.  From the Form Letters tab, select the DYMO Label template.

 3.  Right-click, and then select Copy.

 4.  Right-click anywhere in the template list, and then click Paste.

 5.  Click the Properties button, rename the template, and then click OK.

 6.  Click the Edit button.

CMS launches MS Word with the template open for editing.

 7.  Replace the default name and address fields with name/address fields of your 

choice.

 8.  Close the Word document.

 9.  Click Yes when prompted to save your changes. 

Using the DYMO LabelWriter
Print a single label

 1.  Retrieve a client file, and then select a policy within that file.

 2.  Click Action, and then select one item in each of the first three lists to describe what 

prompted this transaction.

 3.  Select Print, and then select Letter.

 4.  Select DYMO LabelWriter Template (or a custom template if you have created 
one), and then click Print.

MS Word opens the label template.

 5.  In the MS Word document, click the DYMO icon on the MS Word toolbar to print the 

label to the DYMO LabelWriter. 

Print multiple labels

HawkSoft CMS allows you to print multiple labels at once from a report. For 

more information on printing labels from a report, see Mailing Labels.

#Client%20Search%20Overview_..48
Action Menu.htm
#Printing
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Related Topics
Mailing Labels

Email
The HawkSoft CMS email feature provides the tools needed to create and send emails from within a cli-

ent file or policy, and keep a documented history of those emails. 

When emails are sent using CMS,   a log note is created documenting the  date, time, sender, recipient, 

and content of the email.  Emails are automatically attached to the selected client file or policy, and can 

be accessed from the Attachments list as well as from the log note.

For emails to automatically attach to log notes and to the Attachments List,  you 
must have the Auto Attach Sent Emails setting selected in General Settings. The 
instructions in this article assume that you have the setting turned on. See Email.

In this topic:

Setup and Configuration Drag and Drop Emails into a 

Client File

Sending an Email from the 

Action Menu

Sending an Email from the 

Client File View

Emailing Files from the 

Attachments List

Replying to or Forwarding an 

Attached Email

Required Permissions:
To perform this task, no specific CMS user permissions are required. 

Setup and configuration

 You can configure CMS to automatically attach a copy of an email  to a log note, as well as  

to the Attachments list. 

Optional: To configure CMS to automatically attach:

#Setup_and_configuration
#Drag_and_Drop_Emails_into_a_Client_File
#Drag_and_Drop_Emails_into_a_Client_File
#Sending_an_email_from_the_Action_Menu
#Sending_an_email_from_the_Action_Menu
#Sending_an_Email_from_the_Client_File_View
#Sending_an_Email_from_the_Client_File_View
#To_email_attachments_from_a_client_file
#To_email_attachments_from_a_client_file
#Replying_to_or_forwarding_an_attached_email
#Replying_to_or_forwarding_an_attached_email


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1326

 1.  Click the Settings icon, and then select, General Configuration. 

The General Settings screen opens.

 2.  Select the Auto Attach Sent Emails setting. 

See General Settings for more information. 

Prior to creating and sending emails, CMS needs to be configured with your email pro-

vider. See User Email Setup for setup instructions. 

CMS also enables you to create Email Templates for composing standardized emails to 

send to clients.  See Email Templates for more information.

Drag and drop emails into a client file
Although emails are not received by CMS, you can drag and drop emails from your email 

program, into the Attachments list on a client or policy.

Web-based email programs do not enable you to drag and drop 
emails.

Once the email is in the Attachments list, you can open the email for viewing, and reply to 

or forward the email. See Email below. 

Sending an email from the Action Menu
You can create and send emails from within a client file or policy using the Action menu. A 

copy of the email will be attached to both the log note and to the Attachments List. 

For emails to automatically attach to log notes and to the Attachments 
List,  you must have the Auto Attach Sent Emails setting selected in 
General Settings. The instructions in this article assume that you have 
the setting turned on. See Email.

To attach a document to your email, you can drag and drop a file from your computer to 

your new email, or use the Attach button in the Email editor. To send  a document directly 

from  a client file, see Email below, rather than using the Action menu. 

#General%20Settings
#User%20Email%20Setup
#Email%20Templates
#Drag%20and%20Drop%20Documents
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 1.  Retrieve a client file, and then select the Client tab or a policy within that file.

When using a template that contains policy level merge fields 
such as the Company Name or Policy Number, be sure to select 
a policy. See Email Templates for information on setting up a 
template.

 2.  Click Action, and then select one item in each of the first three lists to describe what 

prompted this transaction.

If selecting the Internal option, you will need permissions to 
Internal Print/Blank ACORD Forms/Send Email.

 3.  Select Send Email.

The Email Recipients dialog opens.

 4.  Select or enter the recipients of the email. 

Email Recipients

To display email addresses from your CMS database, select any of the available 

check boxes for the recipient types. The email addresses entered in your CMS data-

base will be included in the list for each recipient type selected.

First Check box – Select this check box to include all email addresses 

entered for the client file. 

The first check box is determined by the Client Type selected on the 

Name and Address screen in the selected client file. For example, if the 

selected client file is a Vendor, you will see a Vendor  check box. 

This check box will display Lead or Prospect if the 
Client Type is set to Customer and the Status is set 
to Prospect or Lead.

See Client Name and Address Information for instructions on entering 

client contact information.

#Email%20Templates
Action Menu.htm
#Client%20Name%20and%20Address%20Information
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Policy Carrier – Select to include all email addresses for the carrier on 
the selected policy. If the Client tab is selected, you will see carrier 

email addresses for each policy on the Client/Policy bar.

See Policy/Company Setup: Company Info for instructions on entering 

contact information for the carrier.

Policy Agent(s) – Select  Policy Agents to include all email addresses  
for Agent 1, 2, and 3 listed on the policy, as well as the customer Pro-

ducer and CSR.

All Users – Select to include email addresses for  all email Users in 
CMS.

Client Type – Select this check box, and then select the type of client 
from the drop-down. When a client type is selected, all email addresses 

from your entire database are listed for that client type.

See User Contact Information for instructions on entering user contact 

information.

Select a recipient from the list, and then click To, Cc, or Bcc, to insert the address in 
that field.

To manually enter a recipient, type the email address in the To, Cc, or Bcc field. 
Use a ; semicolon to separate multiple entries. 

 5.  Click OK once you have finished selecting recipients.

The Select Email Template dialog box opens.

 6.  Select an email template from the list or select **No Template**. 

Selecting a template:

Optional: Select a template category from the available Select Category drop-
down to filter the list of templates.

See Email Templates for instructions on setting up templates.

../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Company Info.htm
#User%20Contact%20Information
#Email%20Templates
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If a user’s email integration is set to use MAPI and an email tem-
plate containing HTML or the **No Template** option is chosen, 
all HTML formatting is removed because MAPI does not support 
HTML emails.

For more information see Email Templates.

 7.  Optional: Select the Add customer/policy information to Subject line check box. 

When checked, the customer name and policy number will display in the subject line 

of the email, unless the selected template contains a subject line.

 8.  Click OK.

The New Message window launches. 

 9.  Complete the body of the email.

See Modifying Email for instructions on adding elements and making formatting 

changes to emails created in the CMS Email Message window.

For Outlook Email users, CMS makes it is easy to modify your 
email templates in Correspondence Setup. See Modifying Email  
Templates for details. If you need to modify an email outside of 
the templates, you need to refer to Outlook's Help for options. 

 10.  Optional: To attach a document to your email, you can drag and drop an attachment 

from your computer to your new email, or use the Attach button in the Email editor. 

 11.  Click Send.

If your email integration is set to MAPI, you might need to click Allow.

 12.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog box opens.

 13.  Add comments as needed, and then click OK.

The body of the email and a link to open the  email  are included in the log note. 

The email is also listed in the Attachments list for the selected client or policy.

Sending an email from the client file view

#Email%20Templates
#Modifying%20Email%20Templates
#Modifying%20Email%20Templates
#User%20Email%20Setup
../../../../../Content/Log Notes/Add Log Entry Comments CSH.htm
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You can create and send an email directly from the Client Information Pane when viewing 

a client. The client file view displays email addresses entered in the Contact section of the 
Name and Address screen when adding or modifying a client. 

See Tour of the Client File for more information on the client view.

A copy of the email will be attached to both the log note and to the Attachments list. 

 1.  Retrieve a client file, and then select the Client tab.

Email addresses are listed in the Client Information Pane.

 2.  Click on the underlined email type (Home, Work, Other) to open the Contact 
Information viewer. 

 If additional email addresses can't fit in the panel, click the underlined More link to 
view all email addresses. 

 3.  Click the Email button.

The Email Recipients dialog opens.

 4.  Select or enter the recipients of the email. 

Email Recipients

To display email addresses from your CMS database, select any of the available 

check boxes for the recipient types. The email addresses entered in your CMS data-

base will be included in the list for each recipient type selected.

First Check box – Select this check box to include all email addresses 

entered for the client file. 

The first check box is determined by the Client Type selected on the 

Name and Address screen in the selected client file. For example, if the 

selected client file is a Vendor, you will see a Vendor  check box. 

This check box will display Lead or Prospect if the 
Client Type is set to Customer and the Status is set 
to Prospect or Lead.

#Client%20Name%20and%20Address%20Information
#Tour%20of%20the%20Client%20File
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See Client Name and Address Information for instructions on entering 

client contact information.

Policy Carrier – Select to include all email addresses for the carrier on 
the selected policy. If the Client tab is selected, you will see carrier 

email addresses for each policy on the Client/Policy bar.

See Policy/Company Setup: Company Info for instructions on entering 

contact information for the carrier.

Policy Agent(s) – Select  Policy Agents to include all email addresses  
for Agent 1, 2, and 3 listed on the policy, as well as the customer Pro-

ducer and CSR.

All Users – Select to include email addresses for  all email Users in 
CMS.

Client Type – Select this check box, and then select the type of client 
from the drop-down. When a client type is selected, all email addresses 

from your entire database are listed for that client type.

See User Contact Information for instructions on entering user contact 

information.

Select a recipient from the list, and then click To, Cc, or Bcc, to insert the address in 
that field.

To manually enter a recipient, type the email address in the To, Cc, or Bcc field. 
Use a ; semicolon to separate multiple entries. 

 5.  Click OK once you have finished selecting recipients.

The Select Email Template dialog box opens.

 6.  Select an email template from the list or select **No Template**. 

Selecting a template:

Optional: Select a template category from the available Select Category drop-
down to filter the list of templates.

See Email Templates for instructions on setting up templates.

#Client%20Name%20and%20Address%20Information
../../../../../Content/Policy-Company Setup/Policy-Company Setup Screens/Company Info.htm
#User%20Contact%20Information
#Email%20Templates
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If a user’s email integration is set to use MAPI and an email tem-
plate containing HTML or the **No Template** option is chosen, 
all HTML formatting is removed because MAPI does not support 
HTML emails.

For more information see Email Templates.

 7.  Optional: Select the Add customer/policy information to Subject line check box. 

When checked, the customer name and policy number will display in the subject line 

of the email, unless the selected template contains a subject line.

 8.  Click OK.

The New Message window launches.

 9.  Complete the body of the email.

See Modifying Email for instructions on adding elements and making formatting 

changes.

For Outlook Email users, CMS makes it is easy to modify your 
email templates in Correspondence Setup. See Modifying Email  
Templates for details. If you need to modify an email outside of 
the templates, you need to refer to Outlook's Help for options. 

 10.  Optional: To attach a document to your email, you can drag and drop an attachment 

from your computer to your new email, or use the Attach button in the Email editor.

 11.  Click Send.

If your email integration is set to MAPI, you might need to click Allow.

 12.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog box opens.

 13.  Add comments as needed, and then click OK.

The body of the email and a link to open the  email  are included in the log note. 

The email is also listed in the Attachments list for the selected client or policy.

 14.  Click Close to close the Contact Information viewer.

#Email%20Templates
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Emailing files from the Attachments List
You can select documents  from the Attachments list to send an email with the documents 

attached. To email a document from your computer (not from the Attachments list), see 

Email.

 1.  Retrieve a client file, and then select the Client tab or a policy within the file.

 2.  Click the Attachments tab.

 3.  Select the attachment(s) you want to email. 

To select multiple attachments, hold down the CTRL key, and click on each item you 

want to send. 

Most email providers limit the size of an email to 20 MB or less. If 
too many attachments are selected, you might not be unable to 
send the email. 

 4.  Right-click on any of the selected items, and then click  Email > Send as Attach-
ment.

The Email Recipients dialog opens.

 5.  Select or enter the recipients of the email. 

Email Recipients

To display email addresses from your CMS database, select any of the available 

check boxes for the recipient types. The email addresses entered in your CMS data-

base will be included in the list for each recipient type selected.

First Check box – Select this check box to include all email addresses 

entered for the client file. 

The first check box is determined by the Client Type selected on the 

Name and Address screen in the selected client file. For example, if the 

selected client file is a Vendor, you will see a Vendor  check box. 
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This check box will display Lead or Prospect if the 
Client Type is set to Customer and the Status is set 
to Prospect or Lead.

See Client Name and Address Information for instructions on entering 

client contact information.

Policy Carrier – Select to include all email addresses for the carrier on 
the selected policy. If the Client tab is selected, you will see carrier 

email addresses for each policy on the Client/Policy bar.

See Policy/Company Setup: Company Info for instructions on entering 

contact information for the carrier.

Policy Agent(s) – Select  Policy Agents to include all email addresses  
for Agent 1, 2, and 3 listed on the policy, as well as the customer Pro-

ducer and CSR.

All Users – Select to include email addresses for  all email Users in 
CMS.

Client Type – Select this check box, and then select the type of client 
from the drop-down. When a client type is selected, all email addresses 

from your entire database are listed for that client type.

See User Contact Information for instructions on entering user contact 

information.

Select a recipient from the list, and then click To, Cc, or Bcc, to insert the address in 
that field.

To manually enter a recipient, type the email address in the To, Cc, or Bcc field. 
Use a ; semicolon to separate multiple entries. 

 6.  Click OK once you have finished selecting recipients.

The Select Email Template dialog box opens.

 7.  Select an email template from the list or select **No Template**.  

Selecting a template:

#Client%20Name%20and%20Address%20Information
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Optional: Select a template category from the available Select Category drop-
down to filter the list of templates.

See Email Templates for instructions on setting up templates.

If a user’s email integration is set to use MAPI and an email tem-
plate containing HTML or the **No Template** option is chosen, 
all HTML formatting is removed because MAPI does not support 
HTML emails.

For more information see Email Templates.

 8.  Optional: Select the Add customer/policy information to Subject line check box. 

When checked, the customer name and policy number will display in the subject line 

of the email, unless the selected template contains a subject line.

 9.  Click OK.

The New Message window launches with the item(s) already attached.

 10.  Complete the body of the email.

See Modifying Email for instructions on adding elements and making formatting 

changes.

For Outlook Email users, CMS makes it is easy to modify your 
email templates in Correspondence Setup. See Modifying Email  
Templates for details. If you need to modify an email outside of 
the templates, you need to refer to Outlook's Help for options. 

 11.  Click Send.

If your email integration is set to MAPI, you might need to click Allow.

 12.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog box opens.

 13.  Add comments as needed, and then click OK.

The body of the email and a link to open the  email  are included in the log note. 

The email is also listed in the Attachments list for the selected client or policy.

#Email%20Templates
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Replying to or forwarding an attached email
CMS enables you to open, and reply to or forward, an email from the Attachments list or 

from a log note. 

From the Attachments list

 1.  Retrieve a client file, and then select the Client tab or a policy within the 
file.

 2.  Click the Attachments tab.

 3.  Right-click on an attached email, and then select one of the following 

options:

 l Email > Reply – Select to reply to the sender of the selected 
email.

 l Email > Reply All – Select to reply to the sender, as well as all 
recipients of the selected email.

 l Email > Forward – Select to forward the selected email to a new 
recipient.

 l Email > Send as Attachment – Select to create a new email 
with the selected email attached. 

The New Message window opens. 

 4.  Select or enter recipients. 

 5.  Complete the body of the email.

See Modifying Email for instructions on adding elements and making 

formatting changes.

For Outlook Email users, CMS makes it is easy to 
modify your email templates in Correspondence 
Setup. See Modifying Email  Templates for details. If 
you need to modify an email outside of the tem-
plates, you need to refer to Outlook's Help for 
options. 

 6.  Click Send. 

#Modifying%20Email%20Templates
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Depending on your email settings, you might need to click Allow.

 7.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog box opens.

 8.  Add comments as needed, and then click OK.

The body of the email and a link to open the  email are included in the 

log note. 

The email is also listed in the Attachments list for the selected client or 

policy.

 For emails to automatically attach to log notes and 
to the Attachments List,  you must have the Auto 
Attach Sent Emails setting selected in General 
Settings. The instructions in this article assume that 
you have the setting turned on. See Email

From a log note

 When replying to an email  attached to a log note, a new  log note is created 

and linked to the original log note.

 1.  Retrieve a client file, and then select the Client tab or a policy within the 
file.

 2.  From the Log Notes window, double-click on the log note that contains 

the attached email. 

 3.  From the View Log window, click on the attached email.

The email opens in the CMS Email viewer.

 4.   Select Reply, Reply All, or Forward.

The New Message window opens. 

If the new message window does not open,  click 
your Email icon in your taskbar to open the viewer.

 5.  Select or enter recipients. 

../../../../../Content/Log Notes/Add Log Entry Comments CSH.htm
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Email Recipients

To display email addresses from your CMS database, select any of the 

available check boxes for the recipient types. The email addresses 

entered in your CMS database will be included in the list for each recip-

ient type selected.

First Check box – Select this check box to include all 

email addresses entered for the client file. 

The first check box is determined by the Client Type selec-

ted on the Name and Address screen in the selected client 

file. For example, if the selected client file is a Vendor, you 

will see a Vendor  check box. 

This check box will display Lead or Pro-
spect if the Client Type is set to Cus-
tomer and the Status is set to Prospect 
or Lead.

See Client Name and Address Information for instructions 

on entering client contact information.

Policy Carrier – Select to include all email addresses for 
the carrier on the selected policy. If the Client tab is selec-

ted, you will see carrier email addresses for each policy on 

the Client/Policy bar.

See Policy/Company Setup: Company Info for instructions 

on entering contact information for the carrier.

Policy Agent(s) – Select  Policy Agents to include all email 
addresses  for Agent 1, 2, and 3 listed on the policy, as well 

as the customer Producer and CSR.

All Users – Select to include email addresses for  all email 
Users in CMS.

#Client%20Name%20and%20Address%20Information
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Client Type – Select this check box, and then select the 
type of client from the drop-down. When a client type is 

selected, all email addresses from your entire database 

are listed for that client type.

See User Contact Information for instructions on entering 

user contact information.

Select a recipient from the list, and then click To, Cc, or Bcc, to insert 
the address in that field.

To manually enter a recipient, type the email address in the To, Cc, or 
Bcc field. Use a ; semicolon to separate multiple entries. 

 6.  Complete the body of the email.

See Modifying Email for instructions on adding elements and making 

formatting changes.

Pasting images into  the CMS Email Editor is not cur-
rently supported. 

 7.   Click Send.

Depending on your email settings, you might need to click Allow.

 8.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog box opens.

 9.  Add comments as needed, and then click OK.

The body of the email, and a link to open the  email are included in the 

log note. The original log note and original email are also included in 

the new log note. 

See Linking Log Notes for more information.

The email is listed in the Attachments list for the selected client or 

policy.

#User%20Contact%20Information
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 For emails to automatically attach to log notes and 
to the Attachments List,  you must have the Auto 
Attach Sent Emails setting selected in General 
Settings. The instructions in this article assume that 
you have the setting turned on. See Email.

Related Topics

 Drag and Drop Documents
Email Templates
Modifying Email
Modifying Email  Templates

Modifying Email

HawkSoft CMS enables you to  make formatting changes and insert merge fields and  logos into  your 

emails when using the CMS Email Message window. 

For Outlook Email users, CMS makes it is easy to modify your email templates in 
Correspondence Setup. See Modifying Email  Templates for details. If you need to 
modify an email outside of the templates, you need to refer to Outlook's Help for 
options. This article applies only when creating an email using  the CMS New Mes-
sage window.

See Communications Overview and Correspondence Setup Overview for more information about the 

different types of correspondence in CMS, and how to create and use templates.

 l Letters, Memos,  Proposals, and the Policy Overview – To 
modify correspondence, see Modifying Correspondence (Letters, 

Memos,  Proposals, and Policy Overview) for details about editing.

 l Text Messaging – To format a text message, see  Text Mes-
saging with Email-to-SMS Services.

This article describes the various formatting options available    when modifying emails within CMS. 

#Drag%20and%20Drop%20Documents
#Email%20Templates
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#Modifying%20Email%20Templates
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In this topic:

Merging Fields Adding Images/Logos to 

Email

Adding Website Links to an 

Email Template

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

How do I get here?

See Email for the different options and required permissions for sending an email. During the process 

of sending an email, you can make modifications, as described in this article, in the CMS Email mes-

sage window. 

Adding merge fields
Merge fields are used to insert information from client or policy files into emails at the time 

it is generated. For example, you can insert a merge field to include  a policy number or car-

rier name in correspondence.

 Some field selections activate the Merge Field Properties dialog. Fol-
low on-screen prompts to insert the field.

 1.  With the Email message window open, position your cursor where the merge field 

information should appear, and then click Insert > Field from the  editing menu bar.

The Select Merge Field to Insert dialog opens.

 2.  Select a field from the list.

Use the Filter Fields and Filter Category to quickly find a field 
name.

#MergeFields
#Adding_images/Logos_to_Email
#Adding_images/Logos_to_Email
#Adding_Website_Links_to_an_Email_Template
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 3.  Optional: If available, select a capitalization format for the field  from the Formatting 
drop-down list.

 l Proper Case – The first letter of each word is capitalized.

 l Upper Case – All letters are capitalized.

 l Lower Case – All letters are lower case.

 4.   Click Insert.

The merge field is inserted and the dialog stays open to add more fields if neces-

sary.

 5.  Reposition your cursor to insert another merge field, as needed.

 6.  Click Close to exit the Select Merge Field to Insert dialog when all fields have 
been inserted.

Formatting merge fields

Edit the font, font size, or color 

 1.  Highlight the entire field, including chevrons: <<text>>.

 2.  Modify the field, as needed.

Use the Format menu or toolbar icons to apply formatting 

and edit the font, font size, or color.

Delete a merge field

 1.  Highlight the entire field, including chevrons: <<text>>.

 2.  Press Delete on your keyboard.

Adding images/logos to email 

Inserting an image into an email does not  insert the actual image. The 
image URL (address) is added to the email.  When the email is 
received, the computer must access  the Internet and download the 
image  into the email.  Images stored on a computer or internal intranet 
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will not be seen by the email recipient.

Pasting images into  a CMS Email is not currently supported. 

 1.  With the Email message window open, position your cursor, and then 

click Insert > Image.

The Image URL dialog opens.

 2.  Enter the image URL.

 3.  Click OK.

Adding website links to an email template

 1.  With the Email message window open, highlight the text to be used for the link.

 2.  Click Insert > Hyperlink.

The Hyperlink dialog box opens.

 3.  Select the hyperlink type from the Type drop-down list.

 4.  Enter the web address in the URL field.

 5.  Click OK.

Click Save, and then click the X to close the Email message window when all changes are made.

Related Topics
Communications Overview
Correspondence Setup Overview
Modifying Email  Templates

Batch Emails

HawkSoft CMS  enables your agency to send the same email to a selected group of  clients in one 

batch. This article describes how to use a report  to send a form email to a large list of customers or pro-

spects. 

#Correspondence%20Setup%20Overview
#Modifying%20Email%20Templates
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For information on configuring HawkSoft CMS to send batch emails, please see Batch Email Setup 

[+Video].

Batch emailing is done at the agency’s own risk.

 l HawkSoft, Inc. is not liable for actions taken by an ISP, a mail host-

ing service, or other email filtering services.

 l It is the agency’s responsibility to know and understand their ISP or 

mail host provider's rules regarding email.

 l Certain state and federal laws may apply to your batch emails, 

depending on the type of emails being sent. Violating these laws 

may result in legal action being taken against the agency. It is the 

agency's responsibility to know and follow the laws of their jur-

isdiction regarding mass emails.

 l Violation of your mail provider's rules could result in black-listing, 

closing of your email account(s) or flagging your email account as a 

source of spam.

 l Configuring the HawkSoft CMS batch email service to comply with 

your ISP or mail host service rules, and creating email templates 

that are spam filter friendly, are the responsibility of the agency.

In this topic:

Creating a Report Sending a Batch Email Track or Cancel Batch 

Emails

Setting user permissions  is typically performed by an Owner/Administrator.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Reports > Advanced Reports > Agency Intelligence (optional) > Sales & Retention 
(optional) > Create New Reports (if needed) > Batch Email

See Setting User Permissions for more information.

#Batch%20Email%20Setup%20[+Video]
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Creating a report

The first step in sending batch emails, is to run a report with a list of clients to send the 

email to. You can use the batch email feature with any of the following reports:  

Advanced Customized Reports

Agency Intelligence Reports

Sales and Retention Reports

Helpful hints for creating a customized Advanced 

Report to generate  batch emails

 l Select Report By > Client (At least one policy must match 
criteria). This setting will minimize duplication of client files.

 l Add reporting fields for any merge field  used in your intended email. 
This will be helpful to determine clients and policies with missing inform-

ation while reviewing the report, and prior to sending the email.

 l Sort the report by clicking on the column headers to look for any 
empty fields.

 l Reduce the number of email recipients by summarizing the report, 
for example by line of business, and then double-click on the group you 

are sending the email to. Then batch print the letters from the sum-

marized report.

See Working with Report Data for information on summarizing the 

report.

Helpful hints for batch emailing from an Agency Intel-

ligence or Sales & Retention report

#Advanced%20Customized%20Reports
#Agency%20Intelligence%20Reports
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 l Select a predefined report

For example: Sales & Retention report:  No Active Auto, to target cus-

tomers renewing in the next 60 days.

 l Double-click in the  cell with the customer count to drill-down to the cus-
tomer information you need for creating the batch email.

 l Reduce the number of letter recipients by summarizing the report, 
for example by line of business, and then double-click on the group you 

are sending the letter to. Then batch print the letters from the sum-

marized report.

See Working with Report Data for information on summarizing the 

report.

Sending a batch email

 1.  Once your report is created, open the report to select the clients  you want to send 

the batch email to. 

 l To select the entire report:

Click File > Send Email.

If Batch Email has not been configured correctly, you will 
be presented with an error message. See Batch Email 
Setup [+Video] for instructions.

 l To select specific items:

 a.  Press and hold the Ctrl key and select specific entries. 

OR

To select a range of line items, select the first item, and then press the 

Shift key to select the last item to be included. 

 b.  Click File > Send Email. 

The Select Email Template dialog opens.

 2.  Select an email template (or **No Template**) from the drop-down list.

#Working%20with%20Report%20Data
#Batch%20Email%20Setup%20[+Video]
#Batch%20Email%20Setup%20[+Video]
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Avoid using a template that includes User Input merge fields. If 
User Input is included, you will be prompted for every email in 
your batch. See Modifying Email  Templates for more information 
on User Input fields.

See Email Templates for more information.

 3.  Select which items to email, depending on the selection made in step 1.

 l All Items – Select to send an email to all clients on the report.  

 l Selected Item(s) – Select this option if you selected specific items or a group 
of items.

 l Range of Items – Enter a range of line items to only send emails to those cli-
ents.

 4.  Optional: Select Create  log entry for each client emailed. 

A log note will be  added to each client or policy included in the batch, and will 

include  the body of the email. 

 5.  Optional: Select  Attach a copy of Email to each client. A copy of the email will be 
included  in the Attachments list, as well as the log note in each client/policy.

This is only available if Create a log entry for each client is selected.

For larger emails, this option can take up a lot of space in your 
database because a copy of each email is added to every client 
or policy included in the batch.

 6.  Optional: Select Suspend Transaction (Tickler). A suspense will be set for each 
email sent.

This is only available if Create a log entry for each client is selected.

Complete the additional Suspense fields.

See Suspending a Log Note for more information.

 7.  Click OK.

The Email from Report window opens.

#Modifying%20Email%20Templates
#Email%20Templates
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 8.  Select the CMS email address type from the To drop-down menu (Primary, Primary 
Home, All, etc.).

The email address  is assigned  based on the email address   entered  in the Contact 
Info section of the Client Name and Address Information screen. If "Primary" is 
selected, the email will be sent to the first email listed in the Contact Information.

 9.  Fill in the Subject line. 

 10.  Complete the body of the email.

If a template was selected, review the email for any needed changes.

See Modifying Email for more information.

 11.  Click Send.

The Start Report Generator Email Process dialog opens.

 12.  Optional: Complete the following email settings:

Notification

 a.  Optional: Enter the email address where you want to send a confirmation 

when the emails have been sent.

 b.  Optional: Click Test Email to verify the notification will be sent correctly.

Options

 a.  Enter a name to help identify the emailed report.

If an email template was selected, the template name appears in this field.

 b.  Set a start date and time for the email to begin sending.

 c.  Select whether to send the email One per Policy, or One per Client.

 l One per Policy – If selected, CMS will send multiple emails to the 
same client if more than one policy is selected for that client on the 

report. You might choose this option when using an email template that 

contains policy related merge fields.  

 l One per Client – If selected, CMS will send the email only to the first 
instance of the client in the report.

Advanced Settings

#Client%20Name%20and%20Address%20Information
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Optional: Check Override client's Mass Email setting to ignore the 
Mass Email setting in each client file. This option is set in the Contact 
Info section of the Client Name and Address Information screen.

Use this setting cautiously. This setting will send an 
email to the client even if they have specifically 
opted out of mass emails from your agency.

 13.  Click Start.

You can now close the Report. A confirmation report email is sent to the address 

indicated in the Notification field in the Start Report Generator Email Process dia-
log when the batch email is complete.

Track or cancel  batch emails 
 l For pending or currently running batch emails 

You can check the status of a batch email and pause or cancel the process if 

needed.

 a.  Right-click the HawkSoft Batch Emailer icon found in the Windows System 

Tray (the hidden icons near the clock of the Windows Taskbar).

 b.   Select Open to view batch email details on the Batch Emailer dialog. 

Pause Process – Click to temporarily pause the batch emails. You can click 
Start Processing to resume at any time.

Exit – Click to cancel the  batch email from this dialog.

To cancel, you can also right-click on the Task bar, select 
Task Manager, and then select Batch Emailer and click 
End Task.

 l For completed batch emails

You can run the Batch Email Report for details for a completed batch.

 1.  Click Reports > Batch Email Reports from the main CMS menu bar.

 2.  Double-click on any batch listed on the report for details.

#Client%20Name%20and%20Address%20Information
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 3.  Close the report when you are done reviewing.

Related Topics
Base Templates
Email Templates
Modifying Email
Advanced Customized Reports

Memos
HawkSoft CMS enables you to use pre-formated templates to create memos intended for an insured, 

company, or additional interest as the recipient. Each template contains relevant merge fields, depend-

ing on the recipient of the memo. 

Additional correspondence that does not fit into one of these three categories should be created using 

a form letter or email.

See Base Templates for more information on modifying existing memo templates. 

See Form Letters and Email for more information.

In this topic:

Creating and Printing a Memo Editing and Printing a Working Copy

Required Permissions:
In order to complete this task, user permissions must be set to include:

Client File > Action Menu

See Setting User Permissions for more information.

Creating and printing a memo

#Base%20Templates
#Email%20Templates
#Advanced%20Customized%20Reports
#Base%20Templates
#Creating_and_Printing_a_Memo
#Editing_and_Printing_a_Working_Copy
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 1.  Retrieve a client file, and then select the Client tab or a policy within that file.

When using a template that contains policy level merge fields 
such as the Company Name or Policy Number, be sure to select 
a policy. See Base Templates for information on setting up a tem-
plate.

 2.  Click Action, and then select one item in each of the first three lists to describe what 

prompted this transaction.

 3.  Select Print/Create > Memo.

 4.  Select one of the following:

 l To Insured

 l To Company

 l To Additional Interest

If more than one Additional Interest exists on the policy, you will be prompted 

to select one.

The CMS Letter Editor opens.

 5.  Replace <<Body of Letter>> with the content of your memo.

 6.  Optional: Save a working copy that can be opened, edited, and printed again. 

Click File, and then check Save Working Copy On Close.

By default, CMS attaches a copy of the memo, which cannot be edited. Selecting 

Save a Working On Close creates a second copy that can be modified, if needed. 

Once a user selects Save Working Copy On Close, that fea-
ture is enabled for all future letters and memos. Uncheck this 
option to turn this setting off for future letters.

 7.  Use the File menu to print and/or attach the memo. 

Print and Close – Select to print the memo. A PDF of the memo is attached to the 
log note and client file.

The Print dialog opens. Modify settings as needed, and then click Print.

#Base%20Templates
Action Menu.htm
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Attach and Close – Select to attach a PDF to the log note and client file without 
printing.

 8.  Click Finish to close the Action menu.

The Add Log Entry Comments dialog opens.

 9.  Add comments as needed, and then click OK.

The memo is attached to the client file as a PDF and can be accessed from within 

the Log Note or from the Attachments tab.  If  Save Working Copy On Close was 
selected, a second copy which can be edited, is also attached.

Editing and printing a working copy
When the Save  Working Copy On Close feature is enabled, a working version of the 
memo is attached to the client file, as well as the permanent PDF document. This working 

copy can be edited and resent to the recipient manually.

 1.  Retrieve the client file, and then select the appropriate policy, or the Client tab.

 2.  Select the Attachments tab.

 3.  Locate the working copy of the memo you want to edit.

The Attachment Type column identifies the working copy with the label Letter. The 
PDF version is identified as an Adobe Acrobat Document.

 4.  Double-click the working copy.

The letter opens in the The CMS Letter Editor.

 5.  Edit the memo, as needed.

See Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy 

Overview) to learn about available editing options.

 6.  Use the File menu to print and/or attach the memo.

Print and Close – Select to print the memo. A PDF of the memo is attached to the 
log note and client file.

The Print dialog opens. Modify settings as needed, and then click Print.

../../../../../Content/Log Notes/Add Log Entry Comments CSH.htm
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Attach and Close – Select to attach a PDF to the log note and client file without 
printing.

The Add Log Entry Comments dialog opens.

 7.  Add comments as needed, and then click OK.

The modified memo is attached to the client file as a PDF. The original  working copy is still 

attached for future modifications.  See Working with Attached Documents Overview to per-

form actions from the Attachments List, such as emailing the memo or sending the memo 

for an electronic signature. 

Related Topics

Base Templates
Email
Form Letter Templates
Form Letters
Modifying Correspondence (Letters, Memos,  Proposals, and Policy Overview)
Text Messaging with Email-to-SMS Services

Proposals
HawkSoft CMS enables you to create proposals to market or re-market  to prospective and existing cli-

ents.   

CMS includes three types of documents that together, create a proposal. Each of these documents are 

based on a customizable template.

 l Cover Letter – A basic letter template.

 l Line of Business – The lines of business in a proposal template include the ACORD Terms and 
Definitions, where applicable, and merge fields to insert data from client or policy files.

 l Post Letter – The post letter is blank by default and is fully customizable.

This article explains how to create proposals in CMS using these three templates. 

For information on creating templates, please see Proposal Templates.
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In this topic:

Creating a Proposal Saving a Proposal as a Draft Accessing a Previously 

Saved Proposal

Required Permissions:
In order to complete this task, user permissions must be set to include:

Client File > Action Menu

See Setting User Permissions for more information.

Creating a proposal

At any point while creating a proposal, you can click Finish Later to 
save your proposal and return to it for completion at a later time. 

See  Proposals and Proposals, below.

 1.  Retrieve a client file, and then select the Client tab or a policy within the file.

The proposal will be added to the Attachments list of the selected Client or policy 

tab.

 2.  Click Action, and then select one item in each of the first three lists to describe what 

prompted this transaction.

 3.  Click Print/Create > Proposals.

The Proposal Manager - Proposals dialog opens.

 4.  Click New.

The Proposal Template Selection dialog opens with the current date entered as 
the default Proposal Name.

 5.   Optional: Modify the Proposal Name.

 6.  Select one or more  policies to include in  this proposal, and then click Next.

#Creating_a_proposal
#Saving_a_Proposal_as_a_Draft
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The Proposal Template Selection dialog refreshes. A blue arrow indicates the 
item you are selecting a  template for.

 7.  Select a template from the Use the following Template drop-down list at the bot-
tom of the dialog.

To print a proposal without a cover or post letter, leave the selection set at <None>, 
and then click Next.

The Current template selections box is updated with the name of the selected 
template.

 8.  Optional: Click Edit to modify the selected template.

The CMS Letter Editor launches the template.

 a.  Edit the template, as needed.

 b.  Click Save & Close. 

(Edited) now appears as part of the template name. 

 9.  Click Next.

A green checkmark displays next to the completed section. 

The blue arrow advances to the next proposal section (typically a line of business).  

 10.  Continue selecting and editing templates for each section of the proposal until all 

are selected.

 11.  Optional: Change the printing order of the templates.

Highlight a list item, and then use the up and down arrows to the right of the Current 
template selections box to re-order the list.

 12.  Click Next.

The Action to Perform dialog box appears.

 13.  Optional: Click Print Preview to see the proposal as it will print.

Click Close to return to the Action to Perform dialog.

 14.  Select whether to Print, Email, and/or Save as an Attachment in the Action to 
Perform dialog box.

 15.  Click Finish.
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 16.  The Proposal Manager dialog now displays the proposal, with the Status marked 
as Completed, the Modify and Print Dates, and a Print Count.

 17.  Click OK.

 18.  Click Finish to close the Action menu.

The Add Log Entry Comments box opens.

 19.  Add comments as needed, and then click OK.

The new proposal is attached to the log note and is listed on the Attachments tab of the 
selected Client or policy tab.

Saving a proposal as a draft
Proposals can be saved as a draft at any point in the creation process and completed at a 

later time.

 1.  Click Finish Later on the Proposal Template Selection dialog box.

The Template Selection dialog closes and the Proposal Manager dialog opens 
with the proposal status set to Draft.

 2.  Click OK.

 3.  Click Finish to close the Action menu.

The Add Log Entry Comments box opens.

 4.  Add comments as needed, and then click OK.

Accessing a previously saved proposal

 1.  Retrieve a client file, and select the Client tab or a policy within the file.

 2.  Click Action, and then select one item in each of the first three lists to describe what 

prompted this transaction.

 3.  Select Print/Create >Proposals.

The Proposal Manager - Proposals dialog opens.

 4.  Select the existing proposal, and then click Edit.

../../../../../Content/Log Notes/Add Log Entry Comments CSH.htm
../../../../../Content/Log Notes/Add Log Entry Comments CSH.htm
Action Menu.htm


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1357

The Proposal Template Selection dialog opens.

 5.   Complete the proposal by continuing with step 5 of Proposals, above. 

Related Topics

Form Letter Templates
Modifying Correspondence (Letters, Memos,  Proposals, and Policy Overview)
Proposal Templates

Client, Policy, and Claims Summaries
Summaries provide a snapshot of client and policy information  that can be printed and given to cus-

tomers or other interested parties.

HawkSoft CMS provides four types of summaries that can be used to compile and print different inform-

ation: Policy Overviews, Detailed Summaries, Dec Views, and Claims Details.

Only an insurance carrier can provide proof of coverage. For this reason, doc-
uments generated in HawkSoft CMS should be used for reference only and not as 
legal proof of coverage or limits.

In this topic:

Creating and Printing the Policy Overview Creating and Printing the Detailed Summary

Creating and Printing the Dec View Creating and Printing the Claim Details

Required Permissions:
In order to complete this task, user permissions must be set to include:

Client File > Action Menu

See Setting User Permissions for more information.

Creating and printing the Policy Overview
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The Policy Overview is an editable document that provides basic agency, carrier, and coverage inform-

ation for the selected policy.

This document uses the Policy Overview base template . This template can be configured to suit 

agency preferences, such as adding an agency logo and choosing the colors of the report dividers. 

Please see Base Templates for more information.

 1.  Retrieve a client file, and then select a policy within that file.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Print/Create, and then Summary.

 4.  Select Policy Overview.

The Policy Overview opens in the CMS Letter Editor.

 5.  Modify the Policy Overview  as needed.

See Modifying Correspondence Templates (Letters, Memos,  Proposals, and Policy Overview) to 

learn about available editing options.

 6.  Optional: Save a working copy to the Attachments List that can be opened and modified in the 

future.

Click File, and then check Save Working Copy On Close.

Once a user selects Save a Working Copy On Close, that feature is 
enabled for all future letters and memos. Uncheck this option to turn this set-
ting off for future letters.

 7.  Use the File menu to print and/or attach the Policy Overview.

Print and Close – Select to print the Policy Overview. A PDF  is attached to the log note and cli-
ent file.

The Print dialog opens. Modify settings as needed, and then click Print.

Attach and Close – Select to attach a PDF to the log note and client file without printing.

 8.  Click Finish to close the  Action menu.

The Add Log Entry Comments dialog box opens.

 9.  Add comments as needed, and then click OK.

#Base%20Templates
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The Policy Overview is attached to the client file as a PDF   and can be accessed from within the log 

note or from the Attachments tab. If Save Working Copy on Close was selected, a second copy that 

can be edited, is also attached.

Creating and printing a Detailed Summary
A Detailed Summary enables you to choose from a list of client and/or policy sections to include. The 

list will vary depending on the policy type.

 1.  Retrieve a client file, and then select a policy within that file.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Print, and then Summary.

 4.  Select Detailed Summary.

The Detailed Summary Options dialog opens with policy related summary options selected by 
default.

Detailed Summary options

This section lists the different Detailed Summary options available for all policies, in addition to 

the options available to certain policy types.

All policies

Section Details

Full Client Information
Lists the insured's name, address, and contact 

information such as phone numbers and email 

addresses

General Policy Information
Lists the general policy information (such as 

company, policy number, policy status, and 

policy dates) of all policies on the client file

Attachments
Lists the names and dates attached of all attach-

ments on the client (if the Client tab is selected), 

Action Menu.htm
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Section Details

or the policy (if a policy tab is selected)

Policy Claims Lists all claims for the selected policy

Client Claims Lists all claims on the client file

Client tab

Section Details

All Active Policies
Lists all policies (plus general policy inform-

ation) with an active or active pending status

Inactive Policies
List all policies (plus general policy information) 

with a non-active status (including prospect 

policies)

Auto policies

Section Details

Coverages Lists coverages for each vehicle on the policy

Vehicles Summary
Creates a summarized list of all vehicles on the 

policy (only includes vehicle number, year, 

make, model, VIN, and Fleet ID)

Vehicles Detail
Creates a  list of all vehicles on the policy, with 

full details for each vehicle

Drivers Summary

Creates a summarized list of all drivers on the 

policy (only includes driver number, name, date 

of birth, last 4 digits of license number, last 4 

digits of social security number, licensed state, 

and hire date)
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Section Details

For security purposes, all 
license numbers and social 
security numbers only show 
the last four digits on printed 
summaries. To create a 
spreadsheet of all drivers 
with full license numbers 
and social security numbers 
shown, see To create a 
blank template or export a 
list of drivers or vehicles.

Drivers Detail
Creates a list of all drivers on the policy, with full 

details for each driver

Fees
Lists all fees on the policy, including policy fee, 

broker fee, SR22 fee, and other fees.

Discounts
Lists all applicable discounts on the policy, 

including multi-car, transfer, renewal, 

homeowner, paid-in-full, and other discounts.

Boat policies

Section Details

Coverages Lists all coverages for all boats on the policy

Boats Summary
Creates a summarized list of all boats on the 

policy (only includes boat name, year, make, 

model, hull ID, and vessel type)

Boats Detail
Creates a list of all boats on the policy, with full 

details for each boat

Operators Summary
Creates a summarized list of all boat operators 

on the policy (only includes operator number, 

../../../../../Content/Clients and Policies/Client Policy Info Screens/Auto/Export  Import Multiple Drivers and Vehicles.htm#Create_a_Blank_Template_or_Export_a_List_of_Drivers_or_Vehicles
../../../../../Content/Clients and Policies/Client Policy Info Screens/Auto/Export  Import Multiple Drivers and Vehicles.htm#Create_a_Blank_Template_or_Export_a_List_of_Drivers_or_Vehicles
../../../../../Content/Clients and Policies/Client Policy Info Screens/Auto/Export  Import Multiple Drivers and Vehicles.htm#Create_a_Blank_Template_or_Export_a_List_of_Drivers_or_Vehicles
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Section Details

name, date of birth, license number, and 

licensed state)

Operators Detail
Creates a list of all boat operators on the policy, 

with full details for each operator

Commercial/other policies

Section Details

Locations Summary
Lists all locations and buildings on the policy 

(without building underwriting details)

Locations Detail
Lists all locations and buildings on the policy, 

including building underwriting details

Coverages
Lists all coverages for each line of business on 

the policy

General Liability Hazards
Lists all general liability hazards (if a Com-

mercial General Liability line of business is on 

the policy)

Work Comp Hazards
Lists all Workers' Compensation hazards (if a 

Workers' Comp. line of business is on the 

policy)

Scheduled Property
Lists all scheduled property for each line of busi-

ness and location on the policy

Unscheduled Property
Lists all unscheduled property for each line of 

business and location on the policy

Additional Interests
Lists all additional interests associated with the 

policy

 5.  Check or uncheck the sections you want to include on the Summary, and then click  OK.
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The default Print dialog opens.

 6.  Select a printer, and then click Print.

To attach a copy of the Detailed Summary to the client file, select the 
HawkSoft Virtual Printer. 

When you click Print, CMS will close the Print dialog and open the Virtual 
Printer Viewer. Follow on screen prompts  in the Virtual Printer Viewer, and 
then click Attach.

See Working with Attachments to perform actions from the Attachments List, 
such as emailing the letter or sending the letter for an electronic signature.

 7.  Click Finish in the Action menu dialog.

The Add Log Entry Comments dialog opens.

 8.  Add comments as needed, and then click OK.

The Detail Summary is printed and the log note is saved. 

If you attached the Detail Summary to the client/policy, see Working with Attachments to perform 

actions from the Attachments List, such as emailing or sending the PDF for an electronic signature. 

Creating and printing the Dec View
The Dec View is a document that provides complete policy information in a format similar to a declar-

ations page from a carrier.

 1.  Retrieve a client file, and then select a policy within that file.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Print/Create, and then Summary.

 4.  Select Dec View.

The CMS Viewer displays the Dec View.

 5.  Click File > Print.

The default Print dialog opens.

#The%20HawkSoft%20Virtual%20Printer
#The%20HawkSoft%20Virtual%20Printer
#Working%20with%20Attached%20Documents%20Overview
../../../../../Content/Log Notes/Add Log Entry Comments CSH.htm
#Working%20with%20Attached%20Documents%20Overview
Action Menu.htm
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 6.  Select a printer.

 To attach a copy of a Dec View to the client file, select the HawkSoft Virtual 
Printer. 

When you click OK, CMS will close the Print dialog and open the Virtual 
Printer Viewer. Follow on screen prompts in the  Virtual Printer Viewer, and 
then click Attach.

See Working with Attachments to perform actions from the Attachments List, 
such as emailing the letter or sending the letter for an electronic signature.

 7.  Click OK.

 8.  Close the Dec View document.

The Action menu appears.

 9.  Click Finish in the Action menu dialog.

The Add Log Entry Comments dialog box opens.

 10.  Add comments as needed, and then click OK.

The Dec View is printed, and the log note is saved. 

If you attached the Dec View to the client/policy, see Working with Attachments to perform actions from 

the Attachments List, such as emailing or sending the PDF for an electronic signature. 

Creating and printing the Claim Details

 1.  Retrieve a client file, and then select a policy within that file.

 2.  Click Action, and then select one item in each of the first three lists to describe what prompted 

this transaction.

 3.  Select Print/Create, and then Summary.

 4.  Select Claim Detail.

The Select Claim dialog displays all claims on the selected policy. If the Client tab was selected 

in step 1, all claims for all policies are listed. 

 5.  Select a claim from the list, and then click View.

#The%20HawkSoft%20Virtual%20Printer
#The%20HawkSoft%20Virtual%20Printer
#Working%20with%20Attached%20Documents%20Overview
../../../../../Content/Log Notes/Add Log Entry Comments CSH.htm
#Working%20with%20Attached%20Documents%20Overview
Action Menu.htm


3/5/2026 Copyright © 2015 HawkSoft, Inc., All Rights Reserved. 1365

The CMS Viewer opens with a summary of the selected claim.

 6.  Click File > Print.

The default Print dialog opens.

 7.  Select a printer.

To attach a copy of the Claim Details to the client file, select the HawkSoft Vir-
tual Printer. 

When you click OK, CMS will close the Print dialog and open the Virtual 
Printer Viewer. Follow on screen prompts in the  Virtual Printer Viewer, and 
then click Attach.

See Working with Attachments to perform actions from the Attachments List, 
such as emailing the letter or sending the letter for an electronic signature.

 8.  Click OK.

 9.  Close the Claim Details.

The Action menu appears.

 10.  Click Finish in the Action menu dialog.

The Add Log Entry Comments dialog opens.

 11.  Add comments as needed, and then click OK.

Related Topics

Form Letters

Modifying Correspondence (Letters, Memos,  Proposals, and 

Policy Overview)
HawkSoft CMS enables you to  make formatting changes and insert merge fields, signatures, and other 

elements into  your letters, memos, proposals, and the Policy Overview. 

See Communications Overview and Correspondence Setup Overview for more information about the 

different types of correspondence in CMS, and how to create and use templates.

#The%20HawkSoft%20Virtual%20Printer
#The%20HawkSoft%20Virtual%20Printer
#Working%20with%20Attached%20Documents%20Overview
../../../../../Content/Log Notes/Add Log Entry Comments CSH.htm
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 l Email – To modify email using the CMS Email Message window, 
see Modifying Email.

 l Text Messaging – To format a text message, see  Text Message 
Templates.

This article describes the various formatting options available    when modifying correspondence created 

directly from a client file within CMS. To modify correspondence templates, see Modifying Cor-

respondence Templates (Letters, Memos,  Proposals, and Policy Overview).

In this topic:

Adding Merge Fields Adding Objects to Correspondence

Adding Images/Logos/Pictures to Cor-

respondence

Adding Page Breaks and Lines

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

How do I get here?

A CMS Letter Editor is available when creating correspondence. The following steps assume you have 

the editing window open. 

Adding merge fields
Merge fields are used to insert information from client or policy files into correspondence at 

the time it is generated. For example, you can insert a merge field to include  a policy num-

ber or carrier name in correspondence.

#Text%20Message%20Templates
#Text%20Message%20Templates
#Modifying%20Correspondence%20Templates%20(Letters,%20Memos,%20Proposals,%20and%20Policy%20Ove...
#Modifying%20Correspondence%20Templates%20(Letters,%20Memos,%20Proposals,%20and%20Policy%20Ove...
#Adding_Merge_Fields
#Adding_Objects_to_Correspondence
#Adding_Images/Logos/Pictures_to_Corespondence
#Adding_Images/Logos/Pictures_to_Corespondence
#Adding_Page_Breaks_and_Lines
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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Some field selections activate the Merge Field Properties dialog. Fol-
low on-screen prompts to insert the field.

 1.  With the Letter Editor open, position your cursor where the merge field information 

should appear, and then click Insert > Field from the  editing menu bar.

The Select Merge Field to Insert dialog opens.

 2.  Select a field from the list.

Use the Filter Fields and Filter Category to quickly find a field 
name.

 3.  Optional: If available, select a capitalization format for the field  from the Formatting 
drop-down list.

 l Proper Case – The first letter of each word is capitalized.

 l Upper Case – All letters are capitalized.

 l Lower Case – All letters are lower case.

 4.   Click Insert.

The merge field is inserted and the dialog stays open to add more fields if neces-

sary.

 5.  Reposition your cursor to insert another merge field, as needed.

 6.  Click Close to exit the Select Merge Field to Insert dialog when all fields have 
been inserted.

Adding a signature

CMS enables you to insert a signature into form letters, proposal, and 

memos. 

See User Signature Setup to scan and set up your signature in CMS. Once 

your signature is set up, use the steps to Add a merge field.

Insert > Field > Agent Signature

The following fields are available for the signature:

#User%20Signature%20Setup
#MergeFields
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Agent Signature (Agent 1)

Agent2 Signature

Agent3 Signature

 l The user creating the correspondence must 

be authorized to use the signature intended 

for this item in order for the signature to dis-

play.

 l When inserting the signature of another user 

on a letter or proposal, the agent's initials must 

appear on the GPI screen in the Agent 1, 

Agent 2, or Agent 3 field.

Formatting merge fields

Edit the font, font size, or color 

 1.  Highlight the entire field, including chevrons: <<text>>.

 2.  Modify the field, as needed.

Use the Format menu or toolbar icons to apply formatting 

and edit the font, font size, or color.

 3.  Click Save & Close when all changes are made.

Delete a merge field

 1.  Highlight the entire field, including chevrons: <<text>>.

 2.  Press Delete on your keyboard.

 3.  Click Save & Close when all changes are made.

Adding objects to correspondence 
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Objects are files such as graphs or tables that can be added to CMS correspondence. 

Objects can be added to correspondence templates as well as correspondence created 

from a client/policy. 

Creating a new object

You can insert a new object, for example a blank Excel spreadsheet, and then 

insert your data directly into the object. 

 1.  With the Letter Editor open, position your cursor, and then click Insert > 
Object.

The Insert Object dialog box opens.

 2.  Select the appropriate Object Type (file), and then click OK.

The CMS Letter Editor refreshes to display the selected object, with 

available editing tools from the corresponding program.

 3.  Modify the object as needed.

Adding an object from an existing file

You can insert a previously saved document, for example an Excel spread-

sheet that contains data.

 1.  With the Letter Editor open, position your cursor, and then click Insert > 
Object.

The Insert Object dialog opens.

 2.  Select Create from File.

 3.  Click Browse.

The Browse dialog opens.

 4.  Select the file, and then click Open.

The path to the object is displayed in the Insert Object dialog.

 5.  Select Link or Display As Icon:
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Link – Inserts a picture of the file contents into your document. The pic-
ture will be linked to the file so that changes to the file will be reflected in 

your document.

Display As Icon – Inserts a picture of the file contents.

 6.  Click OK to insert the object into the template.

Adding images/logos/pictures to correspondence 

Adding an image/logo from your computer

Images saved on your computer or network as JPG, BMP, TIF, or GIF can be 

added to letters, memos, and proposals.

 1.  With the CMS Letter Editor open, position your cursor, and then click 

Insert > Picture.

The Windows®Open dialog opens.

 2.  Browse to locate the image, and then click Open.

Adding an image/logo when creating cor-

respondence from   a client file

When printing correspondence from a client/policy, you can insert images that 

have been attached to  a client/policy  into the correspondence.    The images 

must be saved as JPG, BMP, TIF, or GIF.

 1.  With the  Letter Editor open, position your cursor, and then click Insert > 
Client Image Attachments.

The Select Attachments dialog box opens. Images attached to the 
selected client/policy  are displayed.

 2.  Select the image(s) to insert, and then click OK.

The image is inserted into the document.
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Adding page breaks and lines
Page breaks and lines can be added to correspondence templates as well as cor-

respondence created from a client/policy. 

 l Page Break – Provides a way to manually insert a page break at any point so you 
can determine the flow of the document.

 l Line – Can be used to visually separate one section of text, objects, or pictures from 
another section to make the document more readable.

Adding a page break

Position your cursor, and then click Insert > Page Break.

The break will be visible in the  Print Preview.

Adding a line

 1.  Position your cursor, and then click Insert > Horizontal 
Line.

The Horizontal Line dialog appears.

 2.  Select line height and color.

The preview changes as you modify the line.

 3.  Click OK.

Related Topics

Communications Overview
Correspondence Setup Overview

Merge Field Descriptions
The HawkSoft CMS Letter Editor enables you to create form letters and other types of cor-

respondence. You can add CMS merge fields that pull information from client and policy files into CMS 

templates and letters.

#Correspondence%20Setup%20Overview
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This article describes each CMS merge field used in the letter editor. Each merge field represents the 

information that appears in the finished letter.

See Base Templates for details on inserting merge fields.

Required Permissions:
In order to complete this task, user permissions must be set to include:

Setup > Correspondence Templates

See Setting User Permissions for more information.

Merge Field Descriptions

The available merge fields are listed below the following categories in the  Filter Category 
drop-down.

Agency

These merge fields pull data from the Agency Information dialog.

See  for more information.

Agency fields
<<Agncy_Address>>                      Agency Street Address or PO Box

<<Agncy_City>>                      Agency City

<<Agncy_Email>>                      Agency Email Address

<<Agncy_Fax>>                      Agency Fax Number

<<Agncy_LicNum>>                      Agency License Number

<<Agncy_Name>>                       Agency Name

<<Agncy_Phone>>                      Agency Phone Number

<<Agncy_State>>                      Agency State

<<Agncy_Zip>>                      Agency Zip Code

Client

These merge fields pull data from the Client Name and Address screen.

#Base%20Templates
../../../../../Content/Agency Setup/Manage Agency Users/User Permissions.htm
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See Client Name and Address Information for more information.

The Client CSR Signature and Client Producer Signature fields are  
available only when creating form letters.

Client fields
<<Cli_Address>> Client Street Address or PO Box

<<Cli_Address2>>
Additional space for Client's street 

address or PO Box

<<Agency_ID>>
Client Agency ID (this field must be 

enabled in General Settings)

<<Cli_Email>> Client Email

<<Cli_HomeEmails>>
Client Home Email(s) (multiple 

Home email addresses)

<<Cli_OtherEmails>>
Client Other Email(s) (multiple 

Other email addresses)

<<Cli_WorkEmails>>
Client Work Email(s) (multiple Work 

email addresses)

<<Cli_BusDBAName>> Business DBA Name

<<Cli_BusName>> Business Name

<<Cli_CellPh>> Client Cell Phone Number

<<Cli_City>> Client City

<<CSR>>                      CSR 3 character user ID

<<CSRFull>>                      CSR Full Name

<<CSRCellPhone>> CSR Cell Phone Number

<<CSREmail>>                      CSR Email Address

<<CSRFirstName>> CSR First Name

<<CSRHomePhone>> CSR Home Phone

<<Cli_CSRSignature>> Client CSR Signature

<<CSRWorkPhone>> CSR Work Phone

<<Cust_ID>> HawkSoft assigned Customer ID

#Client%20Name%20and%20Address%20Information
#General%20Settings
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<<Cli_Fax>> Client Fax Phone Number

<<Cli_FeinNum>> Client Federal Tax ID Number

<<Cli_First>>  1st Named Insured First Name

<<Cli_First2>> 2nd Named Insured First Name

<<Cli_Phone>> Client Home Phone Number Phone

<<Cli_Last>> 1st Named Insured Last Name

<<Cli_Last2>> 2nd Named Insured Last Name

<<Cli_LicenseNum>> Client's business license number

<<Cli_MsgPh>> Client Message Phone Number

<<Cli_Middle>>  1st Named Insured Middle Name

<<Cli_Middle2>> 2nd Named Insured Middle Name

<<Cli_NAICSCd>>

Client NAICS Code Number (North 

American Industry Classification 

System)

<<Cli_NAICS>> Client NAICS Description

<<Cli_NamedInsureds>>
Business or First & Last Name of 

1st & 2nd Named Insured

<<Cli_NamedInsuredsAll>>

Business or First & last names of all 

named insureds (if all last names 

are the same, the last name will 

print with the last named insured)

<<Cli_Name1>> 1st Named Insured

<<Cli_Name2>> 2nd Named Insured

<<Cli_NamedInsuredsContacts>>
First & Last Name of 1st & 2nd 

Named Insured

<<Cli_NamedIn-

suredsContactsAll>>

First & last names of all named 

insureds (if all last names are the 

same, the last name will print with 

the last named insured)

<<Cli_FirstNames>>
First Name of 1st & 2nd Named 

Insured
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<<Cli_NamedIn-

suredsAllFirstNames>>
First names of all named insureds

<<Cli_FirstNamesPreferred>>
Preferred names of the 1st & 2nd 

Named Insured

<<Cli_NamedIn-

suredsAllPreferred>>

Preferred names of all named 

insureds (if a named insured does 

not have a preferred name, that 

named insured’s first name will 

print)

<<Cli_OtherPh>> Client Other Phone Number

<<Cli_Pager>> Client Pager Phone Number

<<Cli_Preferred1>>
Preferred name of the 1st Named 

Insured

<<Cli_Preferred2>>
Preferred name of the 2nd Named 

Insured

<<Cli_PrimaryEmail>> Client's Primary email address

<<Cli_ProducerSignature>> Client Producer signature

<<Cli_HomeEmail>>
Client Home Email (1st Home email 

address listed)

<<Cli_OtherEmail>>
Client Other Email (1st Other Email 

Address listed)

<<Cli_PrimPh>>
Client Primary Phone Number (1st 

Phone Number listed)

<<Cli_WorkEmail>>
Client Work Email (1st Work Email 

Address listed)

<<Producer>> Producer 3 character user ID

<<ProducerFull>> Producer Full Name

<<ProducerCellPhone>> Producer Cell Phone Number

<<Producer Email>> Producer Email Address

<<ProducerFirstName>> Producer First Name

<<ProducerHomePhone>> Producer Home Phone Number
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<<ProducerWorkPhone>> Producer Work Phone Number

<<Cli_State>> Client State

<<Cli_Title>> Title for first Named Insured

<<Cli_Title2>> Title for Second Named Insured

<<Website>>                      Client Website

<<Cli_WorkPh>> Client Work Phone Number

<<Cli_Zip>> Client Zip Code

<<CLI_MiscL##>> appear in the Client Filter Category as a merge 
code if you have set up Client Miscellaneous Information. These 
merge fields pull from the Client Misc Info dialog. See Client Mis-
cellaneous Information for details. 

Company

These merge fields pull data from Policy Company Setup.

See Policy-Company Setup Screens Overview for more information.

Company fields
<<Comp_Address>>                      Company Address

<<Comp_City>>                      Company City

<<Comp_ClaimPhone>>                      Company Claims Phone Number

<<Comp_Name>>                     

Company Name - HawkSoft will 

use Formal Name OR Program 

Name if Use Program as Formal 
Name is checked

<<Comp_CustPhone>>                     
Company Customer Service Phone 

Number

<<Comp_Email>>                      Company Email Address

<<Comp_Fax>>                      Company Fax Number

<<Comp_Note>>                      Company Notes

<<Comp_State>>                      Company State

#Client%20Miscellaneous%20Information
#Client%20Miscellaneous%20Information
#Policy-Company%20Setup%20Screens%20Overview
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<<Comp_UnderPhone>>                     
Company Underwriting Phone 

Number

<<Comp_WebSite>>                      Company Website

<<Comp_Zip>>                      Company Zip Code

Lists

These merge fields pull data from various lists throughout CMS. These list merge fields 

are also available below their relevant category. For example, <Driver List> is also found 

in the Policy category.

Personal Profile

These merge fields pull data from the Add/Edit Personal Profile dialog, accessed from 
the Client Name and Address screen.

When you insert a merge field from this category, you will be prompted to select which pro-

file you want to pull data from, if more than one Personal Profile exists on the selected cli-

ent.

See Client Name and Address Information for more information.

Personal Profile fields
<<PP_Anniversary>> Personal Profile Anniversary

<<PP_DoB>> Personal Profile Date of Birth

<<PP_Education>> Personal Profile Level of Education

<<PP_Email>> Personal Profile First Email Address

<<PP_Employer>> Personal Profile Employer

<<PP_First>> Personal Profile First Name

<<PP_Gender>> Personal Profile Gender

<<PP_Hobbies>> Personal Profile Hobbies

<<PP_Income>> Personal Profile Income

<<PP_Last>> Personal Profile Last Name

<<PP_License>> Personal Profile Driver License Num-

#Client%20Name%20and%20Address%20Information
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ber

<<PP_LicenseState>> Personal Profile Driver License State

<<PP_MaritalStatus>> Personal Profile Marital Status

<<PP_Name>> Personal Profile First and Last Name

<<PP_Occupation>> Personal Profile Occupation

<<PP_Phone>> Personal Profile First Phone Number

<<PP_Relationship>>
Personal Profile Relationship 

to Insured

<<PP_Residence>> Personal Profile Residence

Policy

These merge fields pull data from the General Policy Information screen.

See General Policy Information for more information.

Policy fields
<<Pol_AccountNum>>                      Policy Account Number

<<AI List>> Additional Interest List

<<Pol_Address>>                      Policy Garaging Address

<<Pol_Agent>>                     
Policy Agent 1 - Three-character 

User ID

<<Pol_AgentFull>>                      Policy Agent 1 - Full Name

<<Pol_AgentCellPhone>>                     
Policy Agent 1 - Cell Phone Num-

ber

<<Pol_AgentEmail>>                      Policy Agent 1 - Email Address

<<Pol_AgentFirstName>>                      Policy Agent 1 - Full Name

<<Pol_AgentHomePhone>>                     
Policy Agent 1 - Home Phone Num-

ber

<<Pol_AgentSignature>> Policy Agent 1 - Signature

<<Pol_AgentWorkPhone>>                     
Policy Agent 1 - Work Phone Num-

ber

#General%20Policy%20Information
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<<Pol_Agent2>>                     
Policy Agent 2 - Three-character 

User ID

<<Pol_Agent2Full>>                      Policy Agent 2 - Full Name

<<Pol_Agent2CellPhone>>                     
Policy Agent 2 - Cell Phone Num-

ber

<<Pol_Agent2Email>>                      Policy Agent 2 - Email Address

<<Pol_Agent2FirstName>> Policy Agent 2 - First Name

<<Pol_Agent2HomePhone>>                     
Policy Agent 2 - Home Phone Num-

ber

<<Pol_Agent2Signature>> Policy Agent 2 - Signature

<<Pol_Agent2WorkPhone>>                     
Policy Agent 2 - Work Phone Num-

ber

<<Pol_Agent3>>                     
Policy Agent 3 - Three-character 

User ID

<<Pol_Agent3Full>>                      Policy Agent 3 - Full Name

<<Pol_Agent3CellPhone>>                     
Policy Agent 3 - Cell Phone Num-

ber

<<Pol_Agent3Email>>                      Policy Agent 3 - Email Address

<<Pol_Agent3FirstName>>                      Policy Agent 3 - First Name

<<Pol_Agent3HomePhone>>                     
Policy Agent 3 - Home Phone Num-

ber

<<Pol_Agent3Signature>> Policy Agent 3 - Signature

<<Pol_Agent3WorkPhone>>                     
Policy Agent 3 - Work Phone Num-

ber

<<Pol_AgentCode>>                      Company Agent Code

<<Pol_Application Type>>
Application Type field on General 

Policy Information screen

<<Pol_City>>                      Policy Garaging City

<<Pol_Company>>                     

Company Name - HawkSoft will 

use Formal Name OR Program 

Name if Use Program as Formal 
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Name is checked

<<Pol_CompanyUnique>>                      Unique Company Name

<<Contact List>> Contact List

<<Coverage Summary List>> Policy Coverage Summary List

<<Policy_DaysLap>> Days of Lapsed Coverage

<<Driver List>>
Policy Drivers list (personally iden-

tifiable information unmasked)

<<Driver List:secure>>
Policy Drivers list (Personally iden-

tifiable information masked)

<<Pol_EffectDate>>                      Policy Effective Date

<<Pol_ExpireDate>>                      Policy Expiration Date

<<Hazard Detail List>> Policy Hazard List

<<Hazard Summary List>> Policy Hazard Summary List

<<Pol_InceptDate>> Policy Inception Date

<<Pol_LOBs>> Lines of Business Codes

<<Pol_LOBDescriptions>> Lines of Business Descriptions

<<Location List>> List of Locations

<<Pol_NAICCode>>                     
Policy NAIC (National Association 

of Insurance Commissioners) code

<<Pol_Policy Form>> Policy Form

<<Pol_PolNum>>                      Policy Number

<<Policy Summary List>> Policy Summary List

<<Pol_Title>>                      Policy Title

<<Pol_State>>                      Policy State

<<Pol_Premium>>                      Policy Current Rate

<<Premium Detail List>> Premium Detail List

<<Pol_Program>>                      Program Name

<<Quoted Premium>> Quoted Premium

<<Schedule Detail List>> Schedule Detail List

<<Schedule Summary List>> Schedule Summary List

<<Pol_Source>>                      Policy Source
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<<Pol_St>>                      Policy Garaging State

<<Pol_Status>>                      Policy Status

<<Pol_StatDate>>                      Policy Status Date

<<Pol_Term>>                     
Policy Term Period (e.g. 6 months, 

12 months)

<<Vehicle List>> Policy Vehicle List

<<Pol_Zip>>                      Policy Garaging Zip Code

Auto fields
<<Auto_Bi>>                      Bodily Injury Limits

<<Auto_BillPlan>>                      Billing Plan

<<Auto_BrFees>>                      Broker Fees

<<Auto_Address>>                      Garaging Street Address

<<Auto_State>>                      Garaging State

<<Auto_Zip>>                      Garaging Zip Code

<<Auto_Med>>                      Medical Payments Limit

<<Auto_OtherFee>>                      Other Fee

<<Auto_Pd>>                      Property Damage

<<Auto_PipDed>>                      PIP Deductible

<<Auto_Pip>>                      PIP Limit

<<Auto_Sr22Fee>>                      SR22 Fee

<<Auto_Uim>>                      UIM Limit

<<Auto_Umbi>>                      UMBI Limit

Mopro fields
<<Mopro_Lockout>>                      MoPro Lockout Coverage

<<Mopro_Rental>>                      MoPro Rental Coverage

<<Mopro_Tow>>                      MoPro Towing Coverage

<<Mopro_Veh1>>                      MoPro Vehicle 1

<<Mopro_Veh2>>                      MoPro Vehicle 2
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<<Mopro_Veh3>>                      MoPro Vehicle 3

<<Mopro_Veh4>>                      MoPro Vehicle 4

User

These merge fields pull data from the User Profile screens.

See User Setup Overview for more information.

User fields

<<User_Address>>                     
Address of User who is logged into 

CMS.

<<User_City>>                     
City of User who is logged into 

CMS

<<User_Email>>                     
Email Address of User who is 

logged into CMS

<<User First>>
First Name of User who is logged 

into CMS

<<User Initials>>                     
3 character User ID of User who is 

logged into CMS

<<Input>> User Input

<<User Name>>                     
Full Name of User who is logged 

into CMS

<<User_Notes>>                     
Notes found in the User List of User 

who is logged into CMS

<<User_Phone1>>                     
1st Phone Number of User who is 

logged into CMS

<<User_Phone2>>                     
2nd Phone Number of User who is 

logged into CMS

<<User_Phone3>>                     
3rd Phone Number of User who is 

logged into CMS

<<User_PhoneTitle1>>                     
Title (e.g. home, work, etc.) of 1st 

Phone Number of User who is 

#User%20Setup%20Overview
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logged into CMS

<<User_PhoneTitle2>>                     

Title (e.g. home, work, etc.) of 2nd 

Phone Number of User who is 

logged into CMS

<<User_PhoneTitle3>>                     

Title (e.g. home, work, etc.) of 3rd 

Phone Number of User who is 

logged into CMS

<<User_Signature>> User Signature

<<User_State>>                     
State of User who is logged into 

CMS

<<User_Zip>>                     
Zip Code of User who is logged into 

CMS
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